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Άλλο ένα τεύχος έφτασε σε κυκλοφορία.

Κάθε φορά που ξεκινάμε την προσπάθεια για τη δημιουργία ενός νέου
τεύχους μέχρι και την κυκλοφορία του, τα συναισθήματα εναλλάσσονται. Η
αγωνία μετατρέπεται σε χαρά για όλους τους συμμετέχοντες όταν η προσπά-
θεια ολοκληρωθεί.

Αυτή η χρονιά είναι καθοριστική για την διανομή μας καθώς κυκλοφόρησε
η νέα έκδοση 14.04 LTS με πενταετή υποστήριξη καθώς επίσης έχουν ανα-
κοινωθεί νέες δημιουργίες έργων όπως η πολυαναμενόμενη έκδοση για
smartphones και tablets.

Παρά τις δυσκολίες που αντιμετωπίσαμε με κάποια άρθρα, καταφέραμε να
συγκεντρώσουμε υλικό για ένα τεύχος με πλούσια θεματολογία. Σε αυτό το
τεύχος λοιπόν θα διαβάσουμε για τα “9 χρόνια του Ubuntu“, μερικά κόλπα
και συμβουλές για την διανομή μας καθώς και για την απόφαση της Canonical
να κλείσει την υπηρεσία cloud Ubuntu One η οποία χρησιμοποιήθηκε κατα
κόρον από τους χρήστες μιας και υπήρχε προεγκατεστημένη η εφαρμογή στο
λειτουργικό σύστημα.

Επίσης σε αυτό το τεύχος θα βρείτε άρθρα για το Clementine το οποίο
είναι ένα σύγχρονο πρόγραμμα αναπαραγωγής και οργάνωσης μουσικών
αρχείων, για την «ελαφριά» διανομή Lubuntu και πολλά άλλα τεχνικά και
γενικού ενδιαφέροντος θέματα, όπως... (εντάξει δεν γράφω άλλα – γυρίστε
σελίδα και ανακαλύψτε τα!).

Γιώργος Μακρής (ubuderix)
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H άδεια διάθεσης του περιεχομένου του Ubuntistas.

Τα άρθρα που περιλαμβάνονται στο περιοδικό διατίθενται υπό τη άδεια της Creative Commons Attribution-By-Share Alike 3.0 Unported license. Αυτό
σημαίνει ότι μπορείτε να προσαρμόσετε, να αντιγράψετε, να διανείμετε και να διαβιβάσετε τα άρθρα, αλλά μόνο υπό τους ακόλουθους όρους:

• Πρέπει να αποδώσετε την εργασία στον αρχικό συντάκτη (π.χ. με αναφορά ονόματος, email, url) αλλά και στο περιοδικό, αναφέροντας την ονο-
μασία του (Ubuntistas).

• Δεν επιτρέπεται να αποδίδετε το άρθρο/α με τρόπο που να το/α επικυρώνετε ως δική σας εργασία. Και εάν κάνετε αλλαγές, μεταβολές, ή δημιουρ-
γίες πάνω σε αυτήν την εργασία, πρέπει να διανείμετε την προκύπτουσα εργασία με την ίδια άδεια, παρόμοια ή συμβατή.

Περίληψη άδειας: http://tinyurl.com/5nv7kn
Πλήρης άδεια: http://tinyurl.com/yqontc

Τo Ubuntu

Το Ubuntu είναι ένα λειτουργικό σύστημα βασι-
σμένο στον πυρήνα Linux και χρηματοδοτείται από την
Canonical. Είναι Ελεύθερο Λογισμικό / Λογισμικό Ανοι-
χτού Κώδικα (ΕΛ/ΛΑΚ), που σημαίνει ότι διανέμεται χωρίς
χρέωση αλλά και ότι μπορεί να βελτιωθεί από κάθε προ-
γραμματιστή που θέλει να συμμετάσχει στην ομάδα ανά-
πτυξης. Ο στόχος του Ubuntu είναι η παροχή ενός διαρ-
κώς ενημερωμένου, σταθερού λειτουργικού συστήματος
για τον μέσο χρήστη, με ενισχυμένη έμφαση στην ευκολία
χρήσης και εγκατάστασης. Το Ubuntu έχει χαρακτηριστεί
ως η πιο δημοφιλής διανομή Linux για επιτραπέζιους υπο-
λογιστές και σύμφωνα με έρευνες απαριθμεί περισσότε-
ρους από 20.000.000 χρήστες σε όλο τον κόσμο. Στην Ελ-
λάδα το Ubuntu υποστηρίζεται, προωθείται και βελτιώ-
νεται από την κοινότητα Ubuntu-gr.

H κοινότητα Ubuntu-gr

Η ελληνική κοινότητα Ubuntu (Ubuntu-gr) είναι η επίσημη
και εγκεκριμένη κοινότητα για το Ubuntu στην Ελλάδα.
Αποτελείται από χρήστες και φίλους του λειτουργικού συ-
στήματος και σκοπός της είναι η προώθηση του, καθώς
και η υποστήριξη των Ελλήνων χρηστών. Για την επικοι-
νωνία, ενημέρωση και υποστήριξη των μελών της, διαθέ-
τει πλειάδα εργαλείων και δράσεων όπως, φόρουμ, λίστα
ηλεκτρονικού ταχυδρομείου, κοινωνικά δίκτυα...κ.α , ενώ
παράλληλα διοργανώνει συναντήσεις και εκδηλώσεις σε
ολόκληρη την Ελλάδα.
Μια από τις δράσεις της είναι η έκδοση και δωρεάν διά-
θεση του περιοδικού Ubuntistas.

Tο περιοδικό Ubuntistas

To ηλεκτρονικό περιοδικό Ubuntistas είναι το περιοδικό
της ελληνικής κοινότητας Ubuntu. Κυκλοφορεί κάθε τρεις
μήνες και περιέχει άρθρα με νέα από την κοινότητα, το
Ubuntu και τον κόσμο του Linux, χρήσιμους οδηγούς για
το Ubuntu, για γλώσσες προγραμματισμού καθώς και εν-
διαφέρουσες παρουσιάσεις άλλων διανομών Linux, παι-
χνιδιών και διάφορων εφαρμογών. Περιέχει επίσης άρ-
θρα με συνεντεύξεις και απόψεις των μελών της κοινότη-
τας. Το περιοδικό Ubuntistas είναι ανοιχτό σε όλους, αυτό

σημαίνει πως ο καθένας μπορεί να συμμετάσχει
στη δημιουργία του, να κάνει προτάσεις και πα-
ρατηρήσεις για τη βελτίωσή του.

http://tinyurl.com/5nv7kn
http://tinyurl.com/yqontc


 

 

5 χρόνια Ubuntistas! από την ομάδα Ubuntistas

To ηλεκτρονικό περιοδικό Ubuntistas είναι το περιοδικό της ελλη-

νικής κοινότητας Ubuntu. Κυκλοφορεί κάθε τρεις μήνες και περιέχει

άρθρα με νέα από την κοινότητα, το Ubuntu και τον κόσμο του Linux,

χρήσιμους οδηγούς για τοUbuntu, για γλώσσες προγραμματισμού κα-

θώς και ενδιαφέρουσες παρουσιάσεις άλλων διανομών Linux, παιχνι-

διών και διάφορων εφαρμογών. Περιέχει επίσης άρθρα με συνεντεύ-

ξεις και απόψεις των μελών της κοινότητας. Το περιοδικό Ubuntistas

είναι ανοιχτό σε όλους, αυτό σημαίνει πως ο καθένας μπορεί να συμ-

μετάσχει στη δημιουργία του, να κάνει προτάσεις και παρατηρήσεις

για τη βελτίωσή του.

To 18o τεύχος του περιοδικού Ubuntistas είναι ένα τεύχος με ιδιαίτερη ση-

μασία, διότι κατά τη διάρκεια της δημιουργίας του, το περιοδικό Ubuntistas

συμπλήρωσε πέντε χρόνια κυκλοφορίας!

Με αφορμή το ευχάριστo αυτό γεγονός, η ομάδα του περιοδικού

Ubuntistas, ευχαριστεί όλους όσους συνέβαλαν στην δημιουργία του κάθε

τεύχους ως:

• Συντονιστές

• Αρθρογράφοι

• Επιμελητές

• Γραφίστες

• Σελιδοποιητές

Θερμά συγχαρητήρια σε όλους αυτούς τους εθελοντές και ένα μεγάλο ΕΥ-

ΧΑΡΙΣΤΩ για τη σκληρή δουλειά που έκαναν μέσα σε αυτά τα 5 χρόνια όπου

με τις προτάσεις τους και τη συμμετοχή τους, βοήθησαν στη βελτίωση του

περιοδικού κάνοντας πραγματικότητα την κυκλοφορία 18 τευχών!

Καθοριστικός παράγοντας για την επιτυχία του Ubuntistas δεν είναι άλ-

λος από την στήριξη των αναγνωστών του που τίμησαν το περιοδικό και

την προσπάθεια της ομάδας όλο αυτό το διάστημα. Οι αναγνώστες του πε-

ριοδικού δίνουν δύναμη στην ομάδα να συνεχίσει το έργο της.

Ευχαριστούμε θερμά τους αναγνώστες μας και ελπίζουμε το περιοδικό

της ελληνικής κοινότητας του Ubuntu να συνεχίσει να έχει μία θέση στον

υπολογιστή σας!

Ελπίζουμε να δούμε ακόμη περισσότερα τεύχη να κυκλοφορούν και σας

περιμένουμε να βοηθήσετε και εσείς στη δημιουργία ενός ακόμα τεύχους.
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Πίσω στα Περιεχόμενα

http://forum.ubuntu-gr.org/viewtopic.php?f=35&t=29190#p309341
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Πίσω στα Περιεχόμενα

http://ubuntistas.ubuntu-gr.org/download/Ubuntistas_Issue_1_Oktober-November_2008.pdf
http://ubuntistas.ubuntu-gr.org/download/Ubuntistas_Issue_2_Januar-Februar_2009.pdf
http://ubuntistas.ubuntu-gr.org/download/Ubuntistas_Issue_3_March-April_2009.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_4_May-June_2009.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_5_July-August_2009.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_6_September_October_November_December_2009.pdf
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http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_7_January_February_2010.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_8_March_April_2010.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_9_May_June_July_2010.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_10_August_September_October.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Ubuntistas_Issue_11_January_February_March_2011.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/issue12.pdf
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http://files.ubuntu-gr.org/ubuntistas/pdfs/issue13.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/issue_14new.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/issue15.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Issue16.pdf
http://files.ubuntu-gr.org/ubuntistas/pdfs/Issue17.pdf


 

 

9 χρόνια Ubuntu του Νίκου Θ.

Ubuntu. Μια λέξη με πολλές διαφορετικές αλλά όμοιες σημασίες. Ανθρω-

πιά κατά βάση. Μια λέξη προερχόμενη από την Αφρικανική ήπειρο. Εκεί

όπου η λέξη ανθρωπιά, ίσως να έχει μια πιο έντονη σημασία απ’ ότι στο

δυτικό κόσμο. Αυτή τη λέξη λοιπόν χρησιμοποίησε ο Mark Shuttleworth,

ο ιδρυτής ενός λειτουργικού συστήματος για ηλεκτρονικούς υπολογιστές.

Ο Mark Shuttleworth κατάγεται από την Αφρική. Ενός λειτουργικού συστή-

ματος βασισμένο στο ΕΛ/ΛΑΚ: Ελεύθερο Λογισμικό / Λογισμικό Ανοιχτού

Κώδικα. Προσβάσιμο απ’ όλους – διαθέσιμο σε όλους.

 

 

Τι έχει καταφέρει μέχρι στιγμής το Ubuntu; Επιγραμματικά θα αναφέρω:

1. Έχει φέρει το μεγαλύτερο ποσοστό χρηστών ηλεκτρονικών υπολογι-

στών στο GNU/Linux.

2. Έχει δημιουργήσει μια ισχυρή κοινότητα παγκοσμίως με εκατομμύρια

μέλη, όπου τα περισσότερα από αυτά προσφέρουν εθελοντικά.

3. Προσφάτως έκανε το άνοιγμά του στο mobile software για να αποκτή-

σει το δικό του μερίδιο αγοράς και φαίνεται να τα πηγαίνει καλά.

Πιο αναλυτικά, θα ενημερωθείτε στην εικόνα που ακολουθεί. Περιέχει

όλη την ιστορία του Ubuntu από την πρώτη διανομή μέχρι και σήμερα, ση-

μειώνοντας παράλληλα κάποια από τα σημαντικά επιτεύγματα.
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Πίσω στα Περιεχόμενα



 

 

Κλείνει η υπηρεσία Ubuntu One του Νίκου Θ.

Το Ubuntu One είναι η υπηρεσία που διαθέτει το Ubuntu για συγχρο-

νισμό αρχείων και φακέλων του υπολογιστή σας με το σύννεφο (cloud).

Αυτή η υπηρεσία σύντομα θα καταργηθεί. Με το Ubuntu One μπορού-

σαμε μέχρι πρόσφατα να έχουμε έναν ορισμένο αριθμό αρχείων και φακέ-

λων, αναλόγως τον χώρο που είχαμε νοικιάσει, στον υπολογιστή μας αλλά

και στο σύννεφο ταυτόχρονα. Τέτοιου είδους υπηρεσίες, είναι μια καλή

λύση για όσους έχουν αρχεία που δεν θέλουν να χάσουν, είτε σε ενδεχό-

μενη διαγραφή λειτουργικού (format), είτε σε ενδεχόμενη αστοχία υλικού

(hardware failure). Αν ο χώρος είναι αρκετός μπορείτε να πάρετε αντίγραφο

ασφαλείας (backup) ακόμη και ολόκληρου του λειτουργικού σας συστήμα-

τος.

Το Ubuntu One διέθετε και μια εφαρμογή η οποία ερχόταν προ-

εγκατεστημένη στο Ubuntu. Έτσι, μπορούσατε να συγχρονίσετε ότι αρχεία

ή φακέλους θέλατε εσείς, απευθείας από το περιβάλλον εργασίας σας.

Η υπηρεσία Ubuntu One πρόσφερε 5GB αποθηκευτικού χώρου δωρεάν

σε όλους τους χρήστες και η εφαρμογή ήταν διαθέσιμη για πολλές πλατφόρ-

μες (Linux, Windows, Android). Έτσι, μπορούσατε να συγχρονίσετε αρχεία

και φακέλους μεταξύ διαφορετικών λειτουργικών συστημάτων εύκολα και

γρήγορα. Μπορούσατε να νοικιάσετε έξτρα χώρο με κάποιο αντίτιμο ή να

κερδίσετε δωρεάν χώρο μέσω συνδέσμου παραπομπής (referral link).

Προσφάτως η εταιρία πίσω από το Ubuntu One, η Canonical, αποφάσισε

να διακόψει την υπηρεσία. Έχουν βγει σχετικές ανακοινώσεις, ενώ οι χρή-

στες του Ubuntu One θα πρέπει να έχουν λάβει και σχετική ειδοποίηση

μέσω ηλεκτρονικού ταχυδρομείου. Την αρχική δημοσίευση στην σελίδα της

Canonical μπορείτε να την διαβάσετε εδώ.

 

 

Η υπηρεσία θα σταματήσει να λειτουργεί την 1η Ιουνίου 2014, ενώ τα

αρχεία των χρηστών θα παραμείνουν διαθέσιμα για κατέβασμα μέχρι τις

31 Ιουλίου 2014, όπου και θα διαγραφούν οριστικά. Οπότε, φροντίστε ότι

αρχεία έχετε στο Ubuntu One, να τα έχετε κατεβάσει μέχρι τις 31 Ιουλίου

2014. Οι χρήστες της υπηρεσίας που έχουν πληρώσει για ενοικίαση χώρου,

θα τους επιστραφούν τα χρήματα (refund).

Η εφαρμογή Ubuntu One δε συμπεριλαμβάνεται στην νέα έκδοση του

Ubuntu 14.04 LTS. Εναλλακτικές για το Ubuntu One υπάρχουν πάρα πολλές.
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Πίσω στα Περιεχόμενα

http://blog.canonical.com/2014/04/02/shutting-down-ubuntu-one-file-services/


Αυτό που πιθανόν θα σας λείψει, είναι η ευκολία συγχρονισμού λόγω της

εφαρμογής που διέθετε.

Κάποιες άλλες υπηρεσίες cloud διαθέτουν Linux εφαρμογές για συγχρο-

νισμό απευθείας από το περιβάλλον εργασίας σας. Αναζητήστε τις στο δια-

δίκτυο και βρείτε εκείνη που σας ταιριάζει καλύτερα.
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Πίσω στα Περιεχόμενα



 

 

Το Ubuntu 14.04 LTS είναι εδώ του Νίκου Θ.

Στις 17 Απριλίου 2014 κυκλοφόρησε η νέα έκδοση του Ubuntu ονόματι

Trusty Tahr, η οποία θα είναι LTS. Από μια Long Term Support (υποστήριξη

μακράς διαρκείας) έκδοση περιμένουμε σίγουρα ένα πράγμα: Σταθερότητα.

Οι εκδόσεις LTS έχουν αυτό το χαρακτηριστικό, είναι σταθερές και προο-

ρίζονται για συστήματα που θα «τρέχουν» το λειτουργικό σύστημα για πολύ

καιρό. Συνήθως δεν περιμένουμε πολλά νέα χαρακτηριστικά ή μεγάλες αλ-

λαγές, αλλά μια έκδοση σταθερή η οποία θα υποστηρίζεται για πέντε χρό-

νια. Το Trusty Tahr θα υποστηρίζεται έως τον Απρίλιο του 2019.

Μπορείτε να το κατεβάσετε από την κεντρική σελίδα του Ubuntu:

http://www.ubuntu.com/desktop

 

 

Νέα χαρακτηριστικά και λογισμικό

Πυρήνας 3.13

Ο πυρήνας με τον οποίο έρχεται το Ubuntu 14.04 LTS είναι ο 3.13 ο οποίος

είναι βασισμένος στον Linux Kernel 3.13.9 με υποστήριξη για νέο υλικό και

καλύτερη υποστήριξη για SSD δίσκους. Ο πυρήνας αυτός θα ανανεώνεται

ως συνήθως.

Unity

Το προεπιλεγμένο γραφικό περιβάλλον Unity έχει και αυτό βελτιωθεί.

Υπάρχει πλέον η υποστήριξη σε οθόνες High-DPI, καθώς και ένας νέος

screensaver ο οποίος κλειδώνει την οθόνη κρατώντας το wallpaper που

έχετε. Έχετε τη δυνατότητα να αλλάξετε το global menu και να φέρετε τα

κουμπιά στα παράθυρο (αντί στο πάνελ) , όπως επίσης μπορείτε να ενεργο-

ποιήσετε μέσω του CompizConfig Settings Manager το κλικ για ελαχιστο-

ποίηση παραθύρων στον εκκινητή.

LibreOffice

Τo libreoffice αναβαθμίστηκε στην τελευταία σταθερή έκδοση 4.3.2 και

περιέχει και αυτό νέα χαρακτηριστικά.

 

 

11
 

 

Πίσω στα Περιεχόμενα
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Xorg

O Xorg έχει πλέον αναβαθμιστεί στην έκδοση 15.0.1.

Φυσικά και δεν είναι μόνον αυτά τα νέα χαρακτηριστικά και οι αναβαθ-

μίσεις εφαρμογών που περιέχει το Ubuntu 14.04. Αν θέλετε μια πλήρη λί-

στα, καθώς και τα γνωστότερα σφάλματα (bugs) επισκευτείτε την σελίδα:

https://wiki.ubuntu.com/TrustyTahr/ReleaseNotes.

Ubuntu Flavors

Μαζί με το Ubuntu, αναβαθμίστηκαν και όλες οι διανομές τις οποίες ονο-

μάζουμε επίσημα παράγωγα. Αυτές είναι:

1. Edubuntu

2. Kubuntu

3. Lubuntu

4. Mythbuntu

5. Ubuntu GNOME

6. Ubuntu Kylin

7. Ubuntu Studio

8. Xubuntu

Point Releases

Οι LTS εκδόσεις έχουν και ένα άλλο χαρακτηριστικό που ονομάζεται point

release. Κάθε μερικούς μήνες (και βάσει προγράμματος) βγαίνει και ένα

point release. Μια άλλη εικόνα (iso) που περιέχει ακόμη νεότερο λογισμικό,

νεότερο πυρήνα, βελτιώσεις, καθώς και διάφορες αναβαθμίσεις σε προ-

γράμματα. Το πρώτο point release της 14.04 θα είναι το 14.04.1 και αναμέ-

νεται στις 24 Ιουλίου. Το αναλυτικό πρόγραμμα της έκδοσης βρίσκεται εδώ:

https://wiki.ubuntu.com/TrustyTahr/ReleaseSchedule.
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Παρουσίαση διανομής Lubuntu 13.10 του Ιωάννη Παγγέ

Το Lubuntu 13.10 προσφέρει μερικά από τα πλεονεκτήματα του Ubuntu,

αλλά σε μια μινιμαλιστική συσκευασία. Το Lubuntu χρησιμοποιεί ως περι-

βάλλον εργασίας το LXDE αντί του Unity και περιέχει λιγότερα «πράγματα»

από ότι το Ubuntu 13.10.

Για παράδειγμα, δεν θα βρείτε το LibreOffice στο Lubuntu, αντί αυτού θα

βρείτε Abiword και το Gnumeric ως εφαρμογές γραφείου. Μην ανησυχείτε

όμως, εάν θέλετε το LibreOffice, τότε μπορείτε εύκολα να το κατεβάσετε

μέσω του κέντρου λογισμικού του Lubuntu.

Παρακάτω μπορείτε να διαβάσετε μια σύντομη περιγραφή όπως αναφέ-

ρεται από την ιστοσελίδα LXDE:

Το «Lightweight X11 Desktop Environment» είναι ένα γρήγορο περιβάλλον

εργασίας με εξαιρετικές επιδόσεις και εξοικονόμηση ενέργειας. Συντηρείται από

τη διεθνή κοινότητα προγραμματιστών και έρχεται με ένα όμορφο περιβάλλον

εργασίας με πολλαπλή γλωσσική υποστήριξη. Επίσης διαθέτει συντομεύσεις

στο πληκτρολόγιο και επιπλέον χαρακτηριστικά, όπως η περιήγηση με καρτέ-

λες αρχείου. Το LXDE χρησιμοποιεί λιγότερη CPU και λιγότερη μνήμη RAM από

ό,τι άλλα περιβάλλοντα.

Είναι ειδικά σχεδιασμένο για cloud υπολογιστές με χαμηλές προδιαγραφές

υλικού, όπως netbooks, φορητές συσκευές (π.χ. συσκευές MID) ή παλαιότε-

ρους υπολογιστές. Το LXDE μπορεί να εγκατασταθεί σε πολλές διανομές Linux

όπως Debian, Fedora, OpenSUSE και Ubuntu. Είναι το πρότυπο για Knoppix και

lubuntu. Το LXDE τρέχει επίσης στοOpenSolaris και στο BSD. Συνδέεται εύκολα

με εφαρμογές cloud ενώ επιπλέον υποστηρίζει μια πληθώρα προγραμμάτων

που βρίσκονται στο Linux.

Ο πηγαίος κώδικας του LXDE έχει αδειοδοτηθεί εν μέρει υπό τους όρους

της GNU General Public License και εν μέρει από το LGPL.

 

 

Εικόνα 1: Περιβάλλον εγκατάστασης
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Τι νέο υπάρχει στο Lubuntu;

Μερικά από τα χαρακτηριστικά είναι:

• Νέα έκδοση του PCManFM / libfm (1.1.0) που περιλαμβάνει μια ενσω-

ματωμένη μηχανή αναζήτησης.

• Βελτιώσεις, συμπεριλαμβανομένων νέων wallpapers, wallpapers της

κοινότητας, νέα εικονίδια.

• Αφαίρεση του catfish, αφού το PCManFM έχει πάρει τη θέση του για τη

λειτουργία της αναζήτησης.

• Διορθώθηκε ένα πολύ παλιό bug που προκαλεί το gnome-mplayer που

κρασάρει σε κάποιες CPU (P4).

• Πολλές διορθώσεις για το gpicview για την προβολή εικόνων.

Απαιτήσεις συστήματος για την εγκατάσταση

Παρακάτω παρατίθενται οι απαιτήσεις για να εγκαταστήσετε αυτή την

διανομή:

• Ένα σύστημα Pentium II ή Celeron με 128 MB μνήμη RAM είναι πιθανώς

μια σύνθεση που μπορεί να δώσει ένα αργό αλλά χρηστικό σύστημα με

μια τυπική επιφάνεια εργασίας lubuntu.

• Το 13.10 32 bit ISO απαιτεί η CPU σας να έχει Physical Address

Extensions (PAE). Η PAE παρέχεται από την Intel Pentium Pro, συμπερι-

λαμβανομένων και όλων των μετέπειτα επεξεργαστών Pentium-series.

• ια την αρχιτεκτονική PowerPC, είναι γνωστό ότι για να τρέξει σε ένα G4

τρέχει στα 867MHz με 640MB RAM.

• Για Macs που βασίζονται σε Intel, το lubuntu θα πρέπει να τρέξει σε όλα

τα μοντέλα.

Λήψη Lubuntu 13.10

Μπορείτε να κατεβάσετε τη διανομή Lubuntu 13.10 από αυτή τη σελίδα.

Το αρχείο είναι περίπου 702 MB και είναι διαθέσιμο για υπολογιστές σε 32-

bit ή 64-bit. Μπορείτε επίσης να κάνετε λήψη την έκδοση 64-bit για Mac που

βασίζεται στην Intel.

Εγκατάσταση Lubuntu 13.10

Το Lubuntu 13.10 είναι πολύ εύκολο στην εγκατάσταση, η οποία γίνεται

αρκετά γρήγορα. Ακόμη, το Lubuntu 13.10 είναι μια live διανομή, δηλαδή

παρέχει τη δυνατότητα να το δοκιμάσετε χωρίς να κάνετε εγκατάσταση.

Στην αρχή της εγκατάστασης έχετε την επιλογή της εγκατάστασης λογισμι-

κού τρίτων και της λήψης ενημερώσεων. Μπορείτε επίσης να παρακολου-

θήσετε μια σύντομη παρουσίαση, καθώς ολοκληρώνεται η εγκατάσταση

του Lubuntu.

 

 

Εικόνα 2: Προετοιμασία εγκατάστασης
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Εικόνα 3: Τύπος εγκατάστασης

Επιφάνεια εργασίας Lubuntu 13.10

Η επιφάνεια εργασίας είναι λίγο γενική, αλλά λειτουργεί καλά. Για να απο-

κτήσετε πρόσβαση σε εφαρμογές, κάνετε κλικ στο κουμπί στο αριστερό

άκρο της μπάρας και θα δείτε όλες τις εφαρμογές σε κατηγορίες. Μπορείτε

επίσης να αποκτήσετε πρόσβαση στις προτιμήσεις σας, στα εργαλεία του

συστήματος, καθώς και το μενού. Αν δεν σας αρέσει το Unity στο Ubuntu

13.10, τότε θα λατρέψετε το μενού του Lubuntu.

 

 

Εικόνα 4: Επιφάνεια εργασίας

 

 

Εικόνα 5: Μενού
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Λογισμικό Linux που συμπεριλαμβάνεται στο Lubuntu

13.10

Ένα μικρό μέρος του λογισμικού που συμπεριλαμβάνεται στο Lubuntu

13.10:

Παιχνίδια:

• Penguin Canfield

• Penguin Freecell

• Penguin Golf

• Penguin Mastermind

• Penguin Merlin

• Penguin Minesweeper

• Penguin Pegged

• Penguin Solitaire

• Penguin Spider

• Penguin Taipei

• Penguin Taipei-Editor

• Penguin Thornq

Γραφικά:

• Document Viewer

• mtPaint Graphic Editor

• Simple Scan

Διαδίκτυο:

• Firefox

• Pidgin IM

• Sylpheed

• Transmission

Πολυμέσα:

• Audacious

• GNOME Mplayer

• guvcview

• Xfburn

Εφαρμογές Γραφείου:

• Abiword

• Gnumeric

Υλικό διαχείρισης από το Linux στο Lubuntu 13.10

To Lubuntu 13.10 έχει το δικό του κέντρο λογισμικού, το Lubuntu

Software Center. Όπως και το υπόλοιπο αυτής της διανομής, έχει πολύ

πιο μινιμαλιστική εμφάνιση από εκείνη του Ubuntu 13.10 ή ακόμα και του

Kubuntu 13.10. Τα εικονίδια της κατηγορίας δεν έχουν καν χρώμα αλλά

ταιριάζει απόλυτα με τη συνολική εμφάνιση και την αίσθηση του Lubuntu

13.10.

Αν θέλετε να προσθέσετε μια εφαρμογή, κάνετε κλικ στο κουμπί «Εγκα-

τάσταση» και αυτή θα προστεθεί στο καλάθι Apps. Όταν είστε έτοιμοι να

εγκαταστήσετε όλες τις νέες σας εφαρμογές, κάνετε κλικ στο κουμπί Εγκα-

τάσταση Πακέτων στο μενού Apps.

Αν θέλετε να αφαιρέσετε μια εγκατεστημένη εφαρμογή, κάνετε κλικ σε

αυτή και στη συνέχεια κάνετε κλικ στο «Remove» από το κουμπί του συστή-

ματος στο κάτω μέρος του μενού (μπορείτε επίσης να ελέγξετε για σχόλια).
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Εικόνα 6: Software Center

Τελικά συμπεράσματα για το Lubuntu 13.10

Ένα από τα ωραία πράγματα για το Linux είναι ότι υπάρχει μια διανομή

για όλους. Το Lubuntu 13.10 είναι μια μεγάλη επιλογή για εκείνους που δεν

τους αρέσει το Ubuntu, αλλά αν θέλουν να παρακάμψουν Unity και να χρη-

σιμοποιήσουν ένα πιο γρήγορο, ελαφρύ και πιο παραδοσιακό περιβάλλον

εργασίας.

Το Lubuntu 13.10 είναι κατάλληλο για αρχάριους, μέτριους και προχωρη-

μένους χρήστες του Linux.

Πηγές

• Lubuntu 13.10 Review (desktoplinuxreviews.com)

• Lubuntu 13.10 Saucy Salamander released (lubuntu.net)
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Δημιουργώντας ασφαλείς εφαρμογές με τη Ruby on Rails του Γιάννη Κωστάρα

Σε προηγούμενο τεύχος (16) είδαμε πως μπορούμε να αναπτύξουμε

εφαρμογές ιστού με τη βοήθεια της Ruby on Rails. Σ’ αυτό το άρθρο θα φο-

ρέσουμε το καπέλο του χάκερ και θα δούμε πως μπορούμε να αποκτήσουμε

μη εξουσιοδοτημένη πρόσβαση στην εφαρμογή, τον διακομιστή ή το λει-

τουργικό σύστημα που τρέχει την εφαρμογή ιστού. Καθώς και τι πρέπει να

κάνουμε για να προστατέψουμε τα παραπάνω από τέτοιες ενέργειες.

Που είχαμε μείνει; Είχαμε δημιουργήσει μια εφαρμογή ιστού για διαχεί-

ριση έργων και στο τελευταίο βήμα ορίσαμε τη MySQL ως ΒΔ παραγω-

γής. Αυτό που ξεχάσαμε να πούμε είναι πώς να δηλώσουμε στη RoR να

χρησιμοποιήσει τη ΒΔ παραγωγής. Αυτό γίνεται προσθέτοντας στο αρχείο

config/environment.rb τη γραμμή:

..
Rails.env=’production’

και επανεκκινώντας τον WEBrick.

Ελέγξτε αν η mysql τρέχει:

..
$ sudo netstat -tap | grep mysql

κι αν όχι ξεκινήστε τη:

..
$ service mysql restart

Αν θέλετε να δημιουργήσετε την εφαρμογή από την αρχή, τότε ακολου-

θήστε τα παρακάτω διορθωμένα βήματα από το προηγούμενο άρθρο τα

οποία δουλεύουν και με το Ubuntu 13.04:

..

$ sudo apt-get install ruby1.9.1 ruby1.9.1-dev

$ sudo apt-get install rubygems

$ sudo apt-get install nodejs

$ sudo gem sources -a http://gemcutter.org

$ sudo apt-get install sqlite3 libsqlite3-dev

$ sudo gem install sqlite3

$ sudo gem install rails

$ sudo apt-get install ruby-bundler

Με τα βήματα αυτά έχετε “στήσει” πλέον το σύστημά σας για να μπορείτε

να “χτίσετε” την εφαρμογή ή να συνεχίσετε από εκεί που την αφήσατε. Στη

συνέχεια θα υποθέσουμε ότι η εφαρμογή τρέχει στον υποθετικό ιστοτόπο

http://www.todo.gr.

Μέχρι στιγμής ο μόνος χρήστης που μπορεί να προσθέσει/ενημερώσει

έργα είναι ο ρόλος admin. Ο ρόλος αυτός μπορεί πολύ εύκολα να παραβια-

στεί κι ο επίδοξος χάκερ να αποκτήσει πλήρη πρόσβαση στην εφαρμογή και

τη ΒΔ.

Το ερώτημα είναι, ότι ένα ακριβό τείχος προστασίας (Firewall) κι ένα σύ-

στημα ανίχνευσης (Intrusion Detection System) δεν αρκούν για να μας προ-

στατεύσουν; Η απάντηση είναι ότι και τα δυο είναι άχρηστα στις κυβερνο-

επιθέσεις που χρησιμοποιούν τις θύρες TCP 80 και 443 γιατί απλούστατα

αυτές οι θύρες θα πρέπει να παραμείνουν πάντα ανοικτές!

Ο χάκερ Μπάμπης

Το πρώτο πράγμα που παρατήρησε ο ηθικός χάκερ Μπάμπης, ο οποίος
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“έπεσε” στην ιστοσελίδα μας, είναι ότι για την αυθεντικοποίηση δεν χρησι-

μοποιείται καν SSL (HTTPS). Χωρίς να ’χει πρόσβαση στο διακομιστή ή στον

Η/Υ που φιλοξενεί την εφαρμογή, δοκιμάζει διάφορα εργαλεία για να βρει

τον κωδικό του διαχειριστή.

Ένα τέτοιο εργαλείο είναι το Hydra το οποίο θα δοκιμάσει με τη σειρά

διάφορους κωδικούς (brute force attack):

..

$ ./hydra -l admin -P Wordlists/LIST.txt

http://www.todo.gr:3000/tasks/new -t 30

Hydra v7.4.2 (c)2012 by van Hauser/THC & David Maciejak - for legal

purposes only

Hydra (http://www.thc.org/thc-hydra) starting at 2013-07-10 20:15:52

[DATA] 30 tasks, 1 server, 4349 login tries (l:1/p:4349), ~144 tries

per task

[DATA] attacking service http-get on port 3000

[STATUS] 1773.00 tries/min, 1773 tries in 00:01h, 2576 todo in 00:02h

, 30 active

[3000][www] host: 192.168.156.145   login: admin   password: admin

1 of 1 target successfully completed, 1 valid password found

Hydra (http://www.thc.org/thc-hydra) finished at 2013-07-10 20:17:34

Μετά από πολύ λίγο βρήκε τον κωδικό και μας τον έστειλε με email!

Για να του τη σπάσουμε δοκιμάζουμε έναν πιο δύσκολο κωδικό. Αυτή τη

φορά η εκτέλεση του παραπάνω προγράμματος θα επιστρέψει 0 valid

passwords found. Πράγμα που σημαίνει, ότι είναι πολύ σημαντικό να θέ-

τετε δύσκολους κωδικούς χρήστη.

Βέβαια, αυτά τα εργαλεία είναι τόσο αποτελεσματικά όσο και τα λεξικά

(wordlists) που χρησιμοποιούν (Wordlists/LIST.txt στο πιο πάνω πα-

ράδειγμα το οποίο ο Μπάμπης κατέβασε π.χ. από [9, 10]).

Αν κάποιος που έχει το ρόλο admin συνδεθεί στην εφαρμογή π.χ. από κά-

ποιο “ανοικτό” wifi αεροδρομίου ή internet cafe, στο οποίο, πολύ πιθανό,

Άλλα παρόμοια εργαλεία που θα μπορούσε να χρησιμοποιήσει είναι η Medusa και το
ncrack.

Φυσικά μαντεύει ότι το όνομα χρήστη είναι admin. Θα δοκιμάσει επίσης root,
administrator κλπ.

ο παροχέας της υπηρεσίας έχει εγκαταστήσει το κατάλληλο λογισμικό για

να μπορεί να ανιχνεύει την κυκλοφορία δεδομένων, όπως θα δούμε παρα-

κάτω, θα μπορούσε άνετα να υποκλέψει τον base64 κωδικό και να τον απο-

κωδικοποιήσει π.χ. εδώ.

Η προστασία των δεδομένων θα πρέπει να ακολουθεί την τριάδα:

• Εμπιστευτικότητα (Confidentiality), η πληροφορία μπορεί να προσπε-

λαστεί μόνο από εξουσιοδοτημένους χρήστες

• Ακεραιότητα (Integrity), η πληροφορία δεν τροποποιείται από τρίτους

κατά τη μετάδοση, αποθήκευση η ανάκτηση

• Διαθεσιμότητα (Availability), η πληροφορία διατίθεται μόνο στους

εξουσιοδοτημένους χρήστες που τη ζήτησαν (ΕΑΔ ή CIA)!

Υπάρχουν διάφοροι τρόποι για να πετύχουμε ΕΑΔ:

• Αυθεντικοποίηση (authentication) χρηστών

• Εξουσιοδότηση (authorisation) δηλ. ποια δικαιώματα έχει ο χρήστης

για να προσπελάσει κάποια πληροφορία

• Κρυπτογράφηση (encryption)

• Ψηφιακές υπογραφές (digital signatures)

Προσθέτοντας αυθεντικοποίηση χρηστών

Η αυθεντικοποίηση χρηστών περιλαμβάνει τα ακόλουθα βήματα:

1. Εγγραφή (sign-up/register) νέου χρήστη με όνομα χρήστη, κωδικό πρό-

σβασης και διεύθυνση ηλεκτρονικού ταχυδρομείου

2. Σύνδεση (login) εγγεγραμμένου χρήστη μετά από επιτυχή επιβεβαίωση

ονόματος χρήστη και κωδικού.

3. Περιορισμός πρόσβασης (access restriction) του χρήστη σε σελίδες που

επιτρέπονται με βάση το ρόλο του
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4. Αποσύνδεση (logout) του συνδεδεμένου χρήστη από την εφαρμογή.

Σ’ αυτό το άρθρο δε θα προχωρήσουμε στη δημιουργία των παραπάνω μό-

νοι μας [4, 5] αλλά θα χρησιμοποιήσουμε ένα από τα έτοιμα πακέτα αυθε-

ντικοποίησης [3], μάλιστα το πιο διάσημο, το devise [6].

..
$ sudo gem install devise

Στη συνέχεια πρέπει να το δηλώσουμε στην εφαρμογή μας. Προσθέστε το

στο Gemfile:

..
gem ’devise’

και στη συνέχεια εκτελέστε:

..
$ bundle install

Θα πρέπει να δείτε μια γραμμή:

..
Using devise (2.2.4)

Ας ξεκινήσουμε λοιπόν με το devise:

..
$ rails generate devise:install

Η εντολή σας αναφέρει 5 βήματα που πρέπει να κάνετε. Αγνοήστε τα βή-

ματα 1 και 5 για την ώρα, το βήμα 2 το έχουμε ήδη κάνει, οπότε μένει να

κάνετε τα βήματα 3 και 4.

Στη συνέχεια πρέπει να δημιουργήσουμε το μοντέλο User.

..
$ rails generate devise User is_admin:boolean

Ας δούμε τι δημιούργησε η παραπάνω εντολή:

app/models/user.rb

..

class User < ActiveRecord::Base

# Include default devise modules. Others available are:

# :token_authenticatable, :confirmable,

# :lockable, :timeoutable and :omniauthable

devise :database_authenticatable, :registerable,

:recoverable, :rememberable, :trackable, :validatable

# Setup accessible (or protected) attributes for your model

attr_accessible :email, :password, :password_confirmation, :

remember_me

# attr_accessible :title, :body

end

και ο αντίστοιχος πίνακας που θα δημιουργηθεί φαίνεται εδώ:

db/migrate/xxxx_devise_create_users.rb

..
$ rake db:migrate

Για να δούμε τι νέες διαδρομές δημιουργήθηκαν:

..
$ rake routes

Οι διαδρομές που προστέθηκαν από το devise εμφανίζονται με το πρόθεμα

’devise’.

Δώστε στον αγαπημένο σας πλοηγό τη διεύθυνση:

http://localhost:3000/users/sign_up και θα δείτε την παρακάτω εικόνα:

 

 

Εικόνα 1: Εγγραφή στη εφαρμογή todo
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http://localhost:3000/users/sign_up


Πλέον πρέπει να κάνουμε αρκετές αλλαγές στην εφαρμογή μας ώστε

μόνο έγκυροι χρήστες να μπορούν να επεξεργάζονται έργα.

Ας ξεκινήσουμε με το να παρέχουμε ένα υπερσύνδεσμο Sign out σε κάθε

σελίδα. Θα δημιουργήσουμε μια μερική (partial) προβολή γι’ αυτό το σκοπό:

app/views/common/_session.html.erb

..

<%- if user_signed_in? %>

<p>Hello <%= current_user.email %><br />

<%= link_to ’Sign out’, destroy_user_session_path, :method => :

delete %></p>

<%- else %>

<p>

<%= link_to ’Register’, new_user_registration_path %> |

<%= link_to ’Sign in’, new_user_session_path %>

</p>

<%- end %>

και θα την εισάγουμε στο πρότυπο

app/views/layouts/application.html.erb:

..

<div id=”sign_out”>

<%= render ’common/session’ %>

</div>

ακριβώς κάτω από το <body>.

Αν επαναφορτώσετε πάλι την τρέχουσα ιστοσελίδα της εφαρμογής todo

θα δείτε στο πάνω μέρος κάτι σαν:

Hello jkost@freemail.gr

Sign out

Welcome! You have signed up successfully.

Η εφαρμογή πλέον γνωρίζει ποιος είσαι αλλά πρέπει να ξέρει και τι σου

επιτρέπεται να κάνεις μ’ αυτή (authorisation).

Δε θέλουμε λοιπόν όλοι οι χρήστες να μπορούν να επεξεργάζονται έργα,

παρά μόνο όσοι χρήστες διαθέτουν το ρόλο admin. Θέλουμε επομένως ένα

φίλτρο που να εφαρμόζεται κατά την σύνδεση του χρήστη και να ελέγχει αν

αυτός/-ή έχει το το πεδίο is_admin = true.

Θα πρέπει να εισάγουμε την παρακάτω μέθοδο:

app/controllers/application.rb

..

class ApplicationController < ActionController::Base

# Prevent CSRF attacks by raising an exception.

# For APIs, you may want to use :null_session instead.

protect_from_forgery with: :exception

protected
def authorize_admin!

if user_signed_in? && current_user.is_admin
return

elsif user_signed_in?
flash[:notice] = ’You must be an admin to be able to edit tasks’
redirect_to :root

else
flash[:notice] = ’You need to sign in first’
redirect_to new_user_session_path

end
end

end

και στη συνέχεια να αντικαταστήσουμε τη γραμμή βασικής αυθεντικοποίη-

σης (http_basic_authenticate_with) με την ακόλουθη:

app/controllers/tasks_controller.rb

..

class TasksController < ApplicationController

#http_basic_authenticate_with :name => ”admin”, :password => ”admin

”, :except => [:index, :show]

before_filter :authorize_admin!, :except => [:index, :show]

before_action :set_task, only: [:show, :edit, :update, :destroy]

app/controllers/activities_controller.rb
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..

class ActivitiesController < ApplicationController

#http_basic_authenticate_with :name => ”admin”, :password => ”admin

”, :only => :destroy

before_filter :authorize_admin!, :only => :destroy

όπου η προηγούμενη συνθήκη αυθεντικοποίησης είναι σχολιασμένη για να

δούμε τη διαφορά.

Ανανεώστε την ιστοσελίδα της εφαρμογής, συνδεθείτε ως μη διαχειρι-

στής ή εγγραφείτε ως νέος χρήστης και προσπαθήστε να προσθέσετε ένα

νέο έργο, να διαγράψετε ένα υπάρχον, ή να τροποποιήσετε ένα υπάρχον

καθώς και να διαγράψετε μια δραστηριότητα. Η ενέργειά σας δε έχει αντα-

πόκριση και εμφανίζεται το μήνυμα:

You must be an admin to be able to edit tasks

Αλλά πώς μπορούμε να ορίσουμε κάποιον χρήστη ως διαχει-

ριστή; Για την ώρα ο μόνος τρόπος είναι ν’ ανοίξουμε τη ΒΔ

(db/development.sqlite3) εξωτερικά (π.χ. με το πρόσθετο του Firefox)

και να τροποποιήσουμε το πεδίο is_admin κάποιου χρήστη σε 1 (true).

Αντίστοιχα αν δουλεύουμε με τη ΒΔ παραγωγής mysql.

Μπορείτε να βρείτε τις ρυθμίσεις του devise στο αρχείο

config/initializers/devise.rb. Περισσότερα πάνω στην αυθε-

ντικοποίηση στην ιστοσελίδα του OWASP.

Τα πιο συχνά προβλήματα ασφαλείας

Σύμφωνα με τον OWASP, οι δέκα πιο συχνές ευπάθειες ασφαλείας

(vulnerabilities) είναι:

1. Injection (SQL, XML κλπ.)

2. Λανθασμένη αυθεντικοποιήση και διαχείριση συνεδριών (session mana-

gement)

3. Cross-site Scripting (XSS)

4. Ανασφαλής άμεση αναφορά αντικειμένου

5. Ανασφαλής κρυπτογράφηση ή διαφύλαξη κλειδιών

6. Διαρροή πληροφορίας και λαθεμένη διαχείριση λαθών

7. Εκτέλεση κακόβουλου αρχείου

8. Cross-site Request Forgery (CSRF)

9. Χρήση προγραμμάτων που έχουν ευπάθειες

10. Αποτυχία περιορισμού πρόσβασης URL

Θα αναλύσουμε κάποιες, αλλά όχι όλες, από τις παραπάνω στη συνέχεια.

Ενέσεις SQL (SQL Injection)

Ανάλογα με το ΣΔΒΔ που χρησιμοποιείτε υπάρχουν κι οι αντίστοιχες

ευπάθειες (βλ. και αναφορές [14-15]). Ο χάκερ Μπάμπης χρησιμοποιεί το

sqlmap γι’ αυτό το σκοπό (απαιτεί Python 2.7.x):

..

$ ./sqlmap.py -u www.todo.gr -b -f

$ ./sqlmap.py -u www.todo.gr -o --passwords

$ ./sqlmap.py -u www.todo.gr -o --tables -D production

$ ./sqlmap.py -u www.todo.gr -o --columns

-D production -T user

$ ./sqlmap.py -u www.todo.gr -o --dump -D production -T user

αλλά ευτυχώς χωρίς αποτέλεσμα.

Δοκιμάζει και το πρόσθετο για Firefox SQL Inject Me [17] σ’ όλες τις φόρμες

της εφαρμογής (συνολικά 102 κυβερνοεπιθέσεις) χωρίς αποτέλεσμα.

Εσείς δοκιμάστε https://localhost:3000

 

 

22
 

 

Πίσω στα Περιεχόμενα

https://addons.mozilla.org/en-US/firefox/addon/sqlite-manager/
https://www.owasp.org/index.php/Authentication_Cheat_Sheet
https://www.owasp.org/index.php/Authentication_Cheat_Sheet
https://www.owasp.org/index.php/Top_10_2013-Top_10
https://www.owasp.org/index.php/SQL_Injection
https://www.owasp.org/index.php/Authentication_Cheat_Sheet
https://www.owasp.org/index.php/Session_Management_Cheat_Sheet
https://www.owasp.org/index.php/Session_Management_Cheat_Sheet
https://www.owasp.org/index.php/Cross-site_Scripting_(XSS)
https://www.owasp.org/index.php/Command_Injection
https://www.owasp.org/index.php/Cross-Site_Request_Forgery_(CSRF)
https://www.owasp.org/index.php/Unvalidated_Redirects_and_Forwards_Cheat_Sheet
http://www.sqlinjectionwiki.com/Categories.aspx?catId=5#ReferencesSQLInjectionExploitationTools
http://sqlmap.org/
https://addons.mozilla.org/En-us/firefox/addon/sql-inject-me/
https://localhost:3000


Επισκεφθείτε και την ιστοσελίδα http://rails-sqli.org αφιερωμένη ειδικά

για SQLI για τη RoR. Μια πρόσφατη ευπάθεια (για εφαρμογές που χρησιμο-

ποιούν AuthLogic κι όχι Devise) περιγράφεται εδώ και από εδώ μπορείτε να

κατεβάσετε μια εφαρμογή που την αναπαριστά.

Cross Site Scripting (XSS)

Ο Μπάμπης θα δοκιμάσει και πάλι να “σπάσει” την εφαρμογή. Χωρίς να

εγγραφεί στην εφαρμογή, θα προσπαθήσει να βρει ευπάθειες. Προσπαθεί

να δημιουργήσει ένα νέο έργο, να διαγράψει/επεξεργαστεί ένα υπάρχον,

αλλά η εφαρμογή του ζητάει να εγγραφεί. Βρίσκει όμως την πρώτη ευπά-

θεια· μπορεί να δημιουργήσει ενέργειες κι αυτό κάνει:

Description: <script>alert(”GOTCHA!”)</script>

Assignee: b9b1s

Θέλει να δει αν μπορεί να εκτελέσει συνεδρίες Javascript. Ευτυχώς απο-

δεικνύεται πως όχι. Ο κώδικας Javascript αποθηκεύεται ως απλό κείμενο,

διαφορετικά, κάθε φορά που ένας επισκέπτης επισκέπτεται τη σελίδα θα

εμφανιζόταν ένα διαλογικό παράθυρο με το μήνυμα GOTCHA! Με αυτό τον

τρόπο θα μπορούσε να εκτελέσει σκριπτάκια XSS σε ανυποψίαστους χρή-

στες.

Το πρόβλημα εντοπίζεται από τους προγραμματιστές και διορθώνεται εύ-

κολα:

..

class ActivitiesController < ApplicationController

#http_basic_authenticate_with :name => ”admin”, :password => ”admin

”, :only => :destroy

before_filter :authorize_admin!, :only => [:create, :destroy]

Από την έκδοση RoR 3.0 και μετά παρέχεται εξ’ ορισμού προστασία

έναντι XSS. Εντολές ή ετικέτες απενεργοποιούνται (escape) από τα αλ-

φαριθμητικά (strings) προτού σταλούν στον πλοηγό. Αποφύγετε πάσι

θυσία την εντολή raw, όπως π.χ. <%= raw @task.description %> και

προσέξτε σε τι ιστοτόπους συνδέεστε με την εντολή link_to, π.χ.

<%= link_to ”User Website”, user.website %>

όπου user.website μπορεί να είναι:

<a href=”javascript:alert(document.cookie)”>User

Website</a>

Το OWASP παρέχει κι αυτή την πολύ καλή ιστοσελίδα σχετικά με το θέμα.

Θεωρητικά, το πρόβλημα έχει λυθεί από το 2009.

Υπάρχει ένας μηχανισμός που σας επιτρέπει να πείτε στον πλοηγό σας τι

μέρη της ιστοσελίδας είναι “καλά” και τι όχι. Ο μηχανισμός αυτός λέγεται

Content Security Policy και μπορείτε να τον ενεργοποιήσετε ως εξής:

app/controllers/application_controller.rb

..

# Content Security Policy

def set_headers

response.headers[’Content-Security-Policy’] = ”default-src ’none

’; script-src ’self’; style-src https://www.todo.gr”

end

όπου μπορείτε να παραμετροποιήσετε με τις ακόλουθες οδηγίες:

• default-src

• style-src

• frame-src

• script-src

• img-src

• font-src

• object-src

• media-src

• report-uri (αναφέρει για παραβιάσεις των οδηγιών)
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κλπ. Προσέξτε ότι default-src είναι ’none’ πράγμα που σημαίνει ότι δεν

επιτρέπουμε τίποτα που θα μπορούσε να εισάγει περιεχόμενο στη σελίδα

μας. Περιεχόμενο που δεν ανήκει στους ιστοτόπους που περιγράφουμε

απλά δεν εκτελείται καν από τον πλοηγό. Στη συνέχεια, ενεργοποιούμε την

πολιτική αυτή στους ελεγκτές μας ως εξής:

app/controllers/tasks_controller.rb &

app/controllers/activities_controller.rb

..
before_filter :set_headers

Θα πρέπει να ’χετε υπόψιν όμως ότι inline Javascript (και CSS) δεν θα δου-

λέψει με CSP και καλό είναι να την εξάγετε σ’ ένα .js (.css) αρχείο. Χρήσιμο

είναι και αυτό το άρθρο.

Cross-site Request Forgery (CSRF)

Κάποιος χρήστης συνδέεται στον ιστοτόπο μας. Χωρίς να αποσυνδεθεί,

συνδέεται σε μια ιστοσελίδα του χάκερ Μπάμπη. Η ιστοσελίδα αυτή περιέ-

χει μια εικόνα:

<img src=”http://www.todo.gr/tasks/1/destroy”>

η οποία θα διαγράψει το 1ο έργο του χρήστη όταν αυτός την ανοίξει. Ο λό-

γος είναι ότι σε κάθε συναλλαγή με το διακομιστή, ο πλοηγός του χρήστη

στέλνει και το κουλουράκι που περιέχει την ταυτότητα συνεδρίας (session

id), και καθώς η συνεδρία είναι ακόμα ανοιχτή, θα ’χει ως αποτέλεσμα η

εντολή να εξυπηρετηθεί κανονικά από τον Webrick. Φυσικά, ο χρήστης μπο-

ρεί να μην καταλάβει τίποτα, αλλά την επόμενη φορά που θα επισκεφθεί τον

ιστοτόπο μας todo.gr για να δει τα έργα του, θα παρατηρήσει ότι το πρώτο

από αυτά έχει σβηστεί. Αν και το παραπάνω URL δεν θα εκτελεστεί στην έκ-

δοση Rails 4, υπάρχουν πολλά άλλα scripts ή πειραγμένες διευθύνσεις που

μπορεί να σκαρφιστεί ο Μπάμπης για να μπορέσει π.χ. να σας υποκλέψει το

Στην έκδοση Rails 3 και μετά το συγκεκριμένο url δε δουλεύει καθώς η διαγραφή γίνεται
με το ρήμα rest DELETE.

κουλουράκι σας.

Ευτυχώς, η RoR έχει προνοήσει για τέτοιου είδους επιθέσεις:

..

class ApplicationController < ActionController::Base

# Prevent CSRF attacks by raising an exception.

# For APIs, you may want to use :null_session instead.

protect_from_forgery with: :exception

Επίσης, οι πρόσφατες εκδόσεις του Devise φαίνεται να ’χουν διορθώσει

τέτοιες ευπάθειες.

Προσοχή όμως, ευπάθειες XSS μπορούν να ξεπεράσουν τις όποιες προ-

στασίες απέναντι σε CSRF.

Προστασία διακομιστή

Πλέον οι διακομιστές (web servers) είναι αυτοί που δέχονται τις περισσό-

τερες κυβερνοεπιθέσεις. Επίσης, σ’ αυτούς εγκαθίστανται διάφορες εφαρ-

μογές ιστού οι οποίες πολλές φορές διαθέτουν κενά ασφαλείας που εκμε-

ταλλεύονται επίδοξοι χάκερς για ν’ αποκτήσουν πρόσβαση στον διακομιστή

κι από κει στο λειτουργικό σύστημα ή το εσωτερικό δίκτυο.

Με άλλα λόγια, θα πρέπει να προστατεύσουμε τόσο τον ίδιο το διακομι-

στή όσο και τις εφαρμογές που είναι εγκατεστημένες σ’ αυτόν. Οι εταιρίες

και οι οργανισμοί δώσανε μεγαλύτερο βάρος τα τελευταία χρόνια στην προ-

στασία του λειτουργικού συστήματος και του δικτύου παρά στους διακομι-

στές και τις διαδικτυακές εφαρμογές.

Ουσιαστικά, η προστασία πρέπει να ξεκινήσει από τον διακομιστή και ν’

ακολουθήσουν οι εφαρμογές που είναι εγκατεστημένες σ’ αυτόν. Ελέγξτε

το διακομιστή σας για γνωστές ευπάθειες σε ιστοτόπους όπως αυτός εδώ

κι εδώ.

Κατά πρώτον, θα πρέπει να ενημερώνετε τον διακομιστή σας (Webrick

στο παράδειγμά μας) με patches που διορθώνουν κενά ασφαλείας. Παρόλ’

αυτά δε σημαίνει ότι θα πρέπει να εγκαθιστάτε οποιοδήποτε μπάλωμα βγαί-
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νει στα τυφλά αλλά θα πρέπει να το ελέγχεται προτού το εγκαταστήσετε

στο διακομιστή παραγωγής.

Κατόπιν, θα πρέπει να απεγκαταστήσετε όσες από τις εξ’ ορισμού εφαρ-

μογές δε χρειάζονται. Ιδανικά, ο διακομιστής σας θα πρέπει να έχει μόνο

την εφαρμογή ιστού που φιλοξενεί και τίποτ’ άλλο που θα μπορούσε να

αποβεί χρήσιμο σε επίδοξους χάκερ. Επίσης, θα πρέπει να απεγκαταστή-

σετε και όποιες υπηρεσίες και προγράμματα δε χρειάζονται από το Λ.Σ. του

Η/Υ παραγωγής καθώς και λογαριασμούς χρηστών που δεν είναι απαραίτη-

τοι. Για τους υπόλοιπους, και κυρίως για των διαχειριστών και του υπερχρή-

στη, χρησιμοποιήστε πολύ ισχυρούς κωδικούς. Απενεργοποιήστε την απο-

μακρυσμένη πρόσβαση αν δεν είναι απαραίτητη (π.χ. X-Windows, VNC κλπ.).

Αντί των FTP, telnet, χρησιμοποιήστε SSH, SFTP ή FTPS για να συνδεθείτε

απομακρυσμένα με το διακομιστή.

Υπάρχουν διάφορα εργαλεία για να ελέγξετε την ασφάλεια του συστήμα-

τός σας, όπως:

• IBM Internet Security Scanner (http://www.iss.net)

• Retina Network Security Scanner (http://www.eeye.com)

• Nessus (http://www.nessus.org)

• Tripwire (http://www.tripwire.com)

• Brakeman (http://brakemanscanner.org) ειδικά για RoR

• Codesake-dawn (http://rubygems.org/gems/codesake-dawn) RoR

Π.χ. το εμπορικό πρόγραμμα Tripwire σας επιτρέπει να δείτε ποια αρχεία

άλλαξαν από την προηγούμενη φορά που δημιουργήσατε μια καλή κατά-

σταση του διακομιστή σας. Μπορεί να σας στέλνει αναφορές μέσω Η/Τ ανά

τακτά χρονικά διαστήματα με τις αλλαγές/προσθήκες/διαγραφές στο δια-

κομιστή παραγωγής. Στο τέλος της ενότητας δίνουμε ένα παράδειγμα του

brakeman.

Επίσης, θα πρέπει να ενεργοποιήσετε HTTPS. Υπάρχουν πολλοί λόγοι γι’

αυτό. Χωρίς SSL (HTTPS ή Secure HTTP) ο πλοηγός σας ανταλλάσσει πλη-

ροφορίες με τον διακομιστή WebBrick χωρίς κρυπτογράφηση. Έτσι, όποιος

παρακολουθεί το δίκτυο μπορεί πολύ εύκολα να διαβάσει π.χ. το όνομα χρή-

στη και τον κωδικό σας αφού αυτά μεταδίδονται χωρίς κρυπτογράφηση.

Εργαλεία όπως το WebScarab, το Burp, αλλά και sniffers όπως WireShark,

Ettercap, snoop, tcpdump αποτελούν κοινά εργαλεία για τις “ευπάθειες του

ενδιάμεσου” (“man-in-the-middle attacks”). Κι αν νομίζετε ότι είναι πολύ

δύσκολο να σπάσουν το wifi σας ή της εταιρείας σας, την επόμενη φορά

που θα συνδεθείτε στο πρώτο ανοικτό wifi στο αεροδρόμιο, ή σε κάποιο

Internet cafe, σκεφτείτε πολύ καλά τι προγράμματα μπορεί να χρησιμο-

ποιούν όποιοι σας προσφέρουν “δωρεάν” σύνδεση για να μπορέσουν να

σας υποκλέψουν πληροφορίες όπως τους κωδικούς σας (ιδιαίτερα αν συν-

δέεστε σε μη ασφαλείς – βλ. χωρίς HTTPS) διακομιστές αλλά και τη συνε-

δρία σας (session hijacking).

Αλλά τι εννοούμε με τον όρο συνεδρία (session); Το πρωτόκολλο HTTP

δε θυμάται καταστάσεις (είναι εξ’ ορισμού stateless). Δηλ. ο πλοηγός κά-

νει μια αίτηση στο διακομιστή και ο διακομιστής στέλνει μια απάντηση. Από

εκεί και πέρα, ο διακομιστής δε θυμάται τίποτ’ άλλο για τον πελάτη-πλοηγό.

Αλλά τότε, πώς μπορούμε π.χ. να κάνουμε ηλεκτρονικές αγορές; Στις ηλε-

κτρονικές αγορές, πλοηγούμαστε σε πολλές σελίδες και γεμίζουμε το ηλε-

κτρονικό καλάθι μας με προϊόντα. Αφού ο διακομιστής μας “ξεχνάει” μετά

από κάθε ιστοσελίδα, πώς μπορεί να θυμάται τι έχουμε στο καλάθι μας;

Η λύση είναι οι συνεδρίες με τις οποίες ο διακομιστής σας “θυμάται”. Αυτό

επιτυγχάνεται συνήθως με τα ... κουλουράκια (cookies), δηλ. μικρά αρχεία

κειμένου που αποθηκεύει ο πλοηγός σας στο σκληρό σας δίσκο και τα στέλ-

νει κάθε φορά στο διακομιστή. Τα κουλουράκια σας χαρακτηρίζουν μονα-

δικά κι έτσι ο διακομιστής ξέρει ότι είστε πάλι εσείς που τον ενοχλείτε (δηλ.

ο πλοηγός σας) και θυμάται τις προτιμήσεις σας. Στη RoR η συνεδρία εί-

ναι συνήθως ένας 32-bit κωδικός MD5 (δηλ. αυτό που αποθηκεύεται στο

cookie). Μετά τη σύνδεσή σας με το διακομιστή από τη σελίδα σύνδεσης

(login/password), χρησιμοποιείται μια συνεδρία κάθε φορά που επισκέπτε-

στε μια άλλη ιστοσελίδα του ιστοτόπου χωρίς να χρειάζεται κάθε φορά να
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δίνετε πάλι το όνομα χρήστη και τον κωδικό σας. Αν κάποιος σας υποκλέ-

ψει το κουλουράκι που χρησιμοποιείτε για τη συνεδρία τότε θα μπορέσει

να συνδεθεί ως εσείς ακόμα και χωρίς να γνωρίζει το όνομα χρήστη και τον

κωδικό σας!

Στον Firefox, κάνοντας κλικ πάνω στην υδρόγειο σφαίρα στα αριστερά

της διεύθυνσης URL (http://localhost:3000), ή από το μενού Tools→ Page

Info, εμφανίζεται το παράθυρο Page Info με ενεργοποιημένη την καρτέλα

Security. Πατώντας στο κουμπί View Cookies και φιλτράροντας το διαλο-

γικό παράθυρο Cookies ως προς “localhost” βλέπουμε το κουλουράκι που

αποθήκευσε η εφαρμογή μας στον πλοηγό μας (βλ. Εικόνα 2).

 

 

Εικόνα 2: Κουλουράκι στον firefox

Ο χάκερ Μπάμπης θα δοκιμάσει να δει αν διατηρείται η συνεδρία αφού

αποσυνδεθεί. Αφού εγγραφεί και συνδεθεί στην εφαρμογή todo, θα με-

ταφερθεί στην αρχική σελίδα και θα την αποθηκεύσει στ’ αγαπημένα. Θα

μεταφερθεί στη σελίδα προβολής ενός έργου και πάλι θ’ αποθηκεύσει τη

σελίδα στ’ αγαπημένα. Στη συνέχεια θ’ αποσυνδεθεί και θα δοκιμάσει τους

δυο σελιδοδείκτες. Ευτυχώς, η συνεδρία (session) δε διατηρείται κι ο Μπά-

μπης θα χρειαστεί να ξανασυνδεθεί στην εφαρμογή.

Πώς μπορούμε λοιπόν να ενεργοποιήσουμε SSL στο διακομιστή μας; Κατ’

αρχήν θα πρέπει να δημιουργήσετε ένα πιστοποιητικό κι ένα κλειδί:

..

$ hostname

ubuntu

$ mkdir config/certs

$ cd config/certs

$ openssl genrsa -des3 -out server.key 2048

Generating RSA private key, 2048 bit long modulus .................

...............................................................

......................................+++ .....+++ e is 65537 (0

x10001) Enter pass phrase for server.key: Verifying - Enter pass

phrase for server.key:

$ openssl req -new -key server.key -out server.csr

Enter pass phrase for server.key:

...

Common Name (e.g. server FQDN or YOUR name) []:ubuntu

...

$ cp server.key server.key.org

$ openssl rsa -in server.key.org -out server.key

Enter pass phrase for server.key.org:

writing RSA key

$ openssl x509 -req -days 365 -in server.csr -signkey server.key -out

server.crt

Signature ok subject=/C=GR/ST=Some-State/O=Internet Widgits Pty Ltd/

CN=ubuntu

Getting Private key

$ rm server.csr server.key.org

Στη συνέχεια δημιουργήστε ένα νέο εκτελέσιμο αρχείοbin/ssl_rails:

http://www.zunisoft.com/2008/12/kb-webrick-ssl-configuration.html
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..

#!/usr/bin/env ruby

require ’rubygems’

require ’rails/commands/server’

require ’rack’

require ’webrick’

require ’webrick/https’

module Rails

class Server < ::Rack::Server

def default_options

super.merge({

:Port => 3000, # Specify the port here

:environment => (ENV[’RAILS_ENV’] || ”development”).dup,

:daemonize => false,

:debugger => false,

:config => File.expand_path(”config.ru”),

:SSLEnable => true,

:SSLVerifyClient => OpenSSL::SSL::VERIFY_NONE,

:SSLPrivateKey => OpenSSL::PKey::RSA.new( File.open(”

config/certs/server.key”).read),

:SSLCertificate => OpenSSL::X509::Certificate.new(

File.open(”config/certs/server.crt”).read),

:SSLCertName => [[”CN”, WEBrick::Utils::getservername]]

})

end

end

end

APP_PATH = File.expand_path(’../../config/application’, __FILE__)

require_relative ’../config/boot’

require ’rails/commands’

Πλέον μπορείτε να εκκινήσετε τον webrick με την εντολή:

..

$ bundle exec ruby bin/ssl_rails s

=> Booting WEBrick

=> Rails 4.0.4 application starting in development on https

://0.0.0.0:3000

=> Run ‘rails server -h‘ for more startup options

=> Ctrl-C to shutdown server

[2014-03-27 22:44:09] INFO WEBrick 1.3.1

[2014-03-27 22:44:09] INFO ruby 1.9.3 (2012-04-20) [x86_64-linux]

..

[2014-03-27 22:44:09] INFO

Certificate:

Data:

Version: 1 (0x0)

Serial Number: 10668835244306579996 (0x940f5120f80fc21c)

Signature Algorithm: sha1WithRSAEncryption

Issuer: C=GR, ST=Some-State, O=Internet Widgits Pty Ltd, CN=

ubuntu

Validity

Not Before: Mar 24 21:12:32 2014 GMT

Not After : Mar 24 21:12:32 2015 GMT

Subject: C=GR, ST=Some-State, O=Internet Widgits Pty Ltd, CN=

ubuntu

Subject Public Key Info:

Public Key Algorithm: rsaEncryption

Public-Key: (2048 bit)

Modulus:

... WEBrick::HTTPServer#start: pid=3000 port=3000

Επειδή το πιστοποιητικό το δημιουργήσαμε οι ίδιοι και δεν το αγοράσαμε

από κάποιον οργανισμό πιστοποιητικών (Certification Authority) όπως η

Verisign ή το StartSSL, ο πλοηγός σας θα σας προειδοποιήσει γι’ αυτό και

θα πρέπει να προσθέσετε μια εξαίρεση (exception) για να προχωρήσετε. Το

λουκετάκι δίπλα στη διεύθυνση https://localhost:3000 στον πλοηγό δηλώ-

νει ότι η σύνδεση είναι ασφαλής. Κάνοντας κλικ πάνω του, εμφανίζεται το

διαλογικό παράθυρο Page Info, όπως είδαμε προηγούμενα, και πατώντας

το κουμπί View Certificate μπορούμε να δούμε περισσότερες πληροφο-

ρίες για το πιστοποιητικό που δημιουργήσαμε.

Αν θέλετε να έχετε παντού ενεργοποιημένο το SSL τότε φροντίστε να το

δηλώσετε στον Webrick:

config/environments/development.rb

..
config.force_ssl = true

και φυσικά και στο config/environments/production.rb το οποίο

στην ουσία ενεργοποιεί Strict Transport Security.
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Επίσης καλό είναι να δηλώσετε ότι θέλετε μόνο HTTPS κι εδώ:

app/controllers/application_controller.rb

..

# Content Security Policy

def set_csp

response.headers[’Content-Security-Policy’] = ”default-src https;

script-src ’self’; style-src https://www.todo.gr”

end

αλλάζοντας το ’none’ σε https.

Καλό είναι να θυμάστε τα εξής για τα κουλουράκια:

• το μέγεθός τους δεν υπερβαίνει τα 4 Kb

• αποθηκεύονται στον πλοηγό χωρίς κρυπτογράφηση (κωδικοποιούνται

απλώς με κωδικοποίηση Base64) και γι’ αυτό συνιστάται να μην αποθη-

κεύετε κωδικούς, αρ. πιστωτικών καρτών κλπ. σ’ αυτά

• για να αποφευχθεί παραβίαση του κώδικα κατακερματισμού (hash

tampering), δηλ. να μην μπορεί να ξαναχρησιμοποιήσει κάποιος άλλος

το κουλουράκι για να συνδεθεί στην ίδια συνεδρία, προστίθεται στο

τέλος του μια σύνοψη (digest) που επιτρέπει να ελεγχθεί η εγκυρότητα

της συνεδρίας. Ένας τυχαίος αριθμός (π.χ. ο τρέχων χρόνος) αποθηκεύ-

εται επίσης στο κουλουράκι για να αποφευχθεί επαναχρησιμοποίηση

του κουλουρακίου.

Θέτοντας:

config/initializers/session_store.rb

..

Todo::Application.config.session_store :cookie_store, key: ’

_todo_session’, :httponly => true

και επανεκκινώντας τον Webrick δηλώνετε ότι κώδικας javascript που εκτε-

λείται στον πλοηγό δεν μπορεί να προσπελάσει τα κουλουράκια σας.

Οι χάκερ χρησιμοποιούν κι ένα άλλο κόλπο όμως. Αντί να προσπαθούν να

αντιγράψουν το κουλουράκι σας, μπορούν να “υποχρεώσουν“ τον πλοηγό

σας να χρησιμοποιήσει μια προκαθορισμένη συνεδρία που την έχουν δη-

μιουργήσει οι ίδιοι. Η ευπάθεια αυτή ονομάζεται Session Fixation. Ο χάκερ

συνδέεται στην εφαρμογή μας και λαμβάνει ένα κουλουράκι που περιέχει

το session id. Στη συνέχεια, π.χ. με XSS (αν έχει καταφέρει), θέτει αυτό το

κουλουράκι στον πλοηγό σας:

<script>document.cookie=”_session_id=16d5b78abb28e3d6206

b60f22a03c8d9”;</script>.

Όταν ο χρήστης συνδεθεί στην εφαρμογή μας, θα χρησιμοποιεί το ίδιο

session id με τον χάκερ. Ο οδηγός της αναφοράς [1] αναφέρει ως λύση την

εντολή reset_session μετά από κάθε σύνδεση και δημιουργία νέου. Οι πρό-

σφατες εκδόσεις devise έχουν διορθώσει αυτήν την ευπάθεια. Περισσότερα

στην ιστοσελίδα του OWASP.

Βέβαια, δεν αρκεί να ενεργοποιήσετε SSL, θα πρέπει να προστατέψετε

και την πρόσβαση στον διακομιστή και την εφαρμογή ιστού. Κατ’ αρχήν,

καλό είναι να δημιουργήσετε ένα νέο χρήστη (από το Users and Groups),

π.χ. webrick που ν’ ανήκει σε μια νέα ομάδα π.χ. webrick και αφαιρέστε όλα

τα προνόμια από την ομάδα webrick.

..

$ su – webrick

Password:

$ groups

webrick

$ exit

$ sudo cp -r todo /home/webrick/todo

$ sudo chown -R webrick:webrick /home/webrick/todo

$ su - webrick

$ sudo chmod 500 todo

επιτρέποντας έτσι μόνο r-x permissions στο χρήστη webrick. Δώστε ιδιαί-

τερη προσοχή στα δικαιώματα των ακόλουθων ευαίσθητων, από πλευράς

ασφαλείας, αρχεία: config/database.yml

config/initializers/devise.rb

config/initializers/secret_token.rb

Αν σας λείπει το παλιό: sudo apt-get install gnome-system-tools
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db/seeds.rb

db/development.sqlite3

Ανάλογα βήματα μπορείτε να ακολουθήσετε αν χρησιμοποιείτε άλλους

διακομιστές όπως ο Thin ή ο Mongrel οι οποίοι είναι και πιο γρήγοροι από

τον Webrick.

Εργαλεία ελέγχου ευπαθειών

Ας δούμε τι ευπάθειες θα βρει το brakeman:

..

$ cd todo

$ brakeman

...

+SUMMARY+ +-------------------+-------+ | Scanned/Reported | Total |

+-------------------+-------+ | Controllers | 3 | |

Models | 3 | | Templates | 9 | |

Errors | 0 | | Security Warnings | 1 (1) |

+-------------------+-------+ +-----------------+-------+ |

Warning Type | Total | +-----------------+-------+ | Session

Setting | 1 | +-----------------+-------+ +SECURITY WARNINGS

+

+------------+-------+--------+-----------------+----------------------------------------------------+

| Confidence | Class | Method | Warning Type | Message |

+------------+-------+--------+-----------------+----------------------------------------------------+

| High | | | Session Setting | Session

secret should not be included in version control near line 12 |

+------------+-------+--------+-----------------+----------------------------------------------------+

Aπλά σας ζητάει να αποκλείσετε το config/initializers/secret_t

oken.rb από το σύστημα διαχείρισης εκδόσεων (version control) που χρη-

σιμοποιείτε (π.χ. να το προσθέσετε στο .gitignore ή .hgignore αν χρη-

σιμοποιείτε git ή mercurial αντίστοιχα).

Άλλα εργαλεία που μπορείτε να χρησιμοποιήσετε, είναι τα OpenVas και

ZAP [17].

Επίλογος

Σ’ αυτό το άρθρο είδαμε πως μπορούμε να προστατεύσουμε τις εφαρμο-

γές μας ιστού από επίδοξους χάκερς. Η προστασία που θα πρέπει να παρέ-

χουμε πρέπει να ’ναι πολυεπίπεδη, δηλ.:

• προστασία Λ.Σ.

• προστασία διακομιστή

• προστασία ΣΔΒΔ

• προστασία εφαρμογής ιστού

Μιλήσαμε για τις 10 πιο συχνές ευπάθειες ασφαλείας του OWASP και ανα-

λύσαμε τις εξής: XSS, CSFP και SQLI. Είδαμε δυο “θεραπείες” ενάντια σε XSS:

• httponly

• Content Security Policy

ενώ ο ενδιαφερόμενος αναγνώστης θα μπορούσε να κοιτάξει και μια τρίτη,

την X-XSS-Protection. Π.χ. θα μπορούσαμε να προσθέσουμε κι άλλες κεφα-

λίδες ως εξής [16]:

app/controllers/application_controller.rb

..

# Content Security Policy, X-XSS-Protection, X-Frame-Options

def set_headers

response.headers[’Content-Security-Policy’] = ”default-src ’none’;

script-src ’self’; style-src https://www.todo.gr”

response.headers[’X-XSS-Protection’] = ’1’

response.headers[’X-Frame-Options’] = ’SAMEORIGIN’

end

oπου X-Frame-Options προστατεύει από clickjacking. Μπορείτε να την ενερ-

γοποιήσετε καθολικά προσθέτοντας την παρακάτω γραμμή στο

config/environments/development.rb & production.rb

 

 

29
 

 

Πίσω στα Περιεχόμενα

http://code.macournoyer.com/thin/
https://github.com/mongrel/mongrel
http://www.openvas.org/install-packages-v5.html#openvas_ubuntu_obs
https://code.google.com/p/zaproxy/wiki/Downloads
https://cure53.de/xfo-clickjacking.pdf


..

config.action_dispatch.default_headers[’X-Frame-Options’] = ’

SAMEORIGIN’

Είδαμε ακόμα πως να ενεργοποιήσουμε SSL και να προστατέψουμε την

πρόσβαση στον Webrick.

Απλά “ξύσαμε” την κορυφή του παγόβουνου του τεράστιου θέματος που

λέγεται ασφάλεια εφαρμογών και πήρατε μια ιδέα εννοιών και πραγμάτων

που πρέπει να ’χετε υπόψιν σας.

Η RoR παρέχει γενικά καλή προστασία ενάντια πολλών ευπαθειών που

πρέπει να απασχολούν τους προγραμματιστές άλλων γλωσσών προγραμ-

ματισμού. Βέβαια αυτό δεν σημαίνει ότι πρέπει να επαναπαύεστε αλλά θα

πρέπει να σιγουρευτείτε ότι καλύπτεστε τουλάχιστο από τις 10 ευπάθειες

του OWASP προτού θεωρήσετε ότι έχετε πετύχει κάποιο ικανοποιητικό επί-

πεδο ασφαλείας και να δοκιμάσετε κάποιες από τις επικεφαλίδες που περι-

γράφονται στην αναφορά [16].

Υπάρχουν πολλά που δεν καλύφθηκαν από αυτό το άρθρο λόγω έλλειψης

χώρου και χρόνου και από το γεγονός ότι το θέμα είναι απλά τεράστιο. Το

άρθρο δεν πέτυχε το στόχο του να αποτελέσει ένα απλό κείμενο αντιμετώ-

πισης κοινών ευπαθειών, αλλά προσπάθησε.

Τέλος, αν θέλετε να προχωρήσετε περαιτέρω την ανάπτυξη της εφαρμο-

γής, θα πρέπει να αλλάξετε το μοντέλο ώστε κάθε χρήστης να μπορεί να

διαχειρίζεται τα δικά του έργα (κι όχι μόνο ο ρόλος admin) και να ξανατρέ-

ξετε τα εργαλεία που μάθατε σ’ αυτό το άρθρο ώστε να βεβαιιωθείτε ότι

δεν προσθέσατε νέες ευπάθειες. Καλή τύχη.

Πηγές:

1. Ruby on Rails Security Guide

2. Ruby on Rails CheatSheet

Προσοχή στην πρόσφατη ευπάθεια με openssl:
http://seclists.org/fulldisclosure/2014/Apr/231

3. Rails Authentication

4. Powesky B. & Raphael D. (2009), Security on Rails, Pragmatic.

5. Husseiny, K.E. (2012), “Rails: User/Password Authentication from

Scratch, Part I”

6. Husseiny, K.E. (2012), “Rails: User/Password Authentication from

Scratch, Part II”

7. Mishra, “Devise Authentication in Rails 3 (Updated for devise 2).

8. Morin M. (2013), “Step 3: Authentication with Devise”

9. M3g9tr0n (2012), “Cracking Story – How I CrackedOver 122Million SHA1

and MD5 Hashed Passwords”

10. M3g9tr0n, Thireus, CrackTheHash (2013), “Look Back on 2012’s Famous

Hash Leaks – Wordlist, Analysis, and New Cracking Techniques”

11. The OpenSSL Toolkit

12. OpenSSL command-line HowTo

13. WEBrick SSL Configuration (2008)

14. TroyHunt (2013), “Everything you wanted to know about SQL injection

(but were afraid to ask)”

15. Salvari S. (2013), “SQL Injection Tutorial: All common SQL injection

problems and Solutions”

16. West M. (2013), “Browser-side security: Mitigate the risk for XSS”

17. Lampe J. (2013), “OWASP Top Ten Testing and Tools for 2013”

18. Poweski B., Raphael D. (2009), Security on Rails, Pragmatic.

 

 

30
 

 

Πίσω στα Περιεχόμενα

https://www.owasp.org/index.php/Main_Page
http://guides.rubyonrails.org/security.html
https://www.owasp.org/index.php/Ruby_on_Rails_Cheatsheet
http://seclists.org/fulldisclosure/2014/Apr/231
https://www.ruby-toolbox.com/categories/rails_authentication
http://rubysource.com/rails-userpassword-authentication-from-scratch-part-i
http://rubysource.com/rails-userpassword-authentication-from-scratch-part-i
http://rubysource.com/rails-userpassword-authentication-from-scratch-part-ii
http://rubysource.com/rails-userpassword-authentication-from-scratch-part-ii
http://railskey.wordpress.com/2012/05/16/devise-authentication-in-rails-3/
http://ruby.about.com/od/blog/ss/Step-3-Authentication-With-Devise.htm
http://blog.thireus.com/cracking-story-how-i-cracked-over-122-million-sha1-and-md5-hashed-passwords
http://blog.thireus.com/cracking-story-how-i-cracked-over-122-million-sha1-and-md5-hashed-passwords
http://blog.thireus.com/look-back-on-2012s-famous-password-hash-leaks-wordlist-analysiGs-and-new-cracking-techniques
http://blog.thireus.com/look-back-on-2012s-famous-password-hash-leaks-wordlist-analysiGs-and-new-cracking-techniques
http://petio.org/tools/openssl.html
http://www.madboa.com/geek/openssl/
http://www.zunisoft.com/2008/12/kb-webrick-ssl-configuration.html
http://www.troyhunt.com/2013/07/everything-you-wanted-to-know-about-sql.html
http://www.troyhunt.com/2013/07/everything-you-wanted-to-know-about-sql.html
http://www.breakthesecurity.com/2013/02/sql-injection-tutorial-all-common-sql.html 
http://www.breakthesecurity.com/2013/02/sql-injection-tutorial-all-common-sql.html 
http://parleys.com/play/529bee0be4b039ad2298ca0b
http://resources.infosecinstitute.com/owasp-top-ten-testing-and-tools-for-2013/


 

 

LibreOffice Writer – Πίνακες (Μέρος 5ο) του Γιάννη Κωστάρα

Το LibreOffice διαθέτει πολλές δυνατότητες δημιουργίας και επεξεργα-

σίας πινάκων.

Με τον όρο πίνακας εννοούμε ένα πλέγμα γραμμών και στηλών. Τα πλαί-

σια που δημιουργούνται με αυτό το τρόπο ονομάζονται κελιά (cells). Κελί,

δηλαδή, είναι ένα πλαίσιο μέσα σε ένα πίνακα, που δημιουργείται από τη

διατομή μιας γραμμής και μιας στήλης. Ένας πίνακας, όπως μάθατε στα μα-

θηματικά λυκείου, ονομάζεται από τον αριθμό γραμμών και στηλών του.

Π.χ. ένας πίνακας 2x3 έχει 2 γραμμές και 3 στήλες.

Ο πίνακας μας δίνει έναν ιδανικό τρόπο για να στοιχίζουμε το κείμενό μας,

να δημιουργούμε λίστες, φόρμες κλπ. Μπορούμε να εισάγουμε κείμενο ή

γραφικά σε ανεξάρτητα κελιά, περιγράμματα και σκίαση. Όπως θα δούμε

στη συνέχεια, μπορούμε να δημιουργήσουμε ένα πίνακα με συγκεκριμένο

μέγεθος, αριθμό κελιών.

Δημιουργία Πίνακα

Υπάρχουν διάφοροι τρόποι δημιουργίας ενός πίνακα. Ο πιο εύκολος ίσως

είναι από το κουμπί Table της βασικής γραμμής εργαλείων (βλ. Εικόνα 1).

Επιλέγοντας με το ποντίκι το κάτω βελάκι δεξιά του κουμπιού, εμφανίζεται

ένα πλέγμα στο οποίο σέρνοντας το ποντίκι ορίζετε τον αριθμό γραμμών και

στηλών του πίνακα που θέλετε να δημιουργήσετε. Κάντε κλικ στη διάσταση

που θέλετε, κι ένας νέος πίνακας τόσων γραμμών και στηλών που διαλέξατε

εισάγεται στο έγγραφό σας στο σημείο του δρομέα.

 

 

Εικόνα 1: Εισαγωγή πίνακα nxm

Ένας άλλος τρόπος είναι πατώντας πάνω στο κουμπίTable είτε από το με-

νού Table→ Insert→ Table είτε από το μενού Insert→ Table εμφανίζεται

το διαλογικό παράθυρο της εικόνας 2.

 

 

Εικόνα 2: Διαλογικό παράθυρο εισαγωγής πίνακα
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Από το παράθυρο αυτό, πέραν των γραμμών και των στηλών, μπορείτε να

ορίσετε ένα όνομα για τον πίνακα, αν ο πίνακας θα περιλαμβάνει μια κεφα-

λίδα (η οποία θα μπορεί να επαναλαμβάνεται σε κάθε σελίδα αν ο πίνακας

καταλαμβάνει περισσότερες από μια σελίδες), να ορίσετε αν θα φαίνεται ή

όχι το περίγραμμά του, ακόμα και να χρησιμοποιήσετε κάποια από τα έτοιμα

πρότυπα πινάκων (κουμπί AutoFormat).

 

 

Εικόνα 3: Αυτόματη μορφοποίηση πίνακα

Αφού επιλέξετε τις ρυθμίσεις που επιθυμείτε, πατήστε στο κουμπί OK.

Ας δημιουργήσουμε τον παρακάτω πίνακα 3x3 ως άσκηση:

Χαρακτηρισμός

Διαστάσεις

Διπλής πυκνότητας

ή Double Density

(DD)

Υψηλής

πυκνότητας ή High

Density (HD)

3,5” 720 Kb 1,44 Mb

5 ¼” 360 Kb 1,2 Mb

Ο πίνακας αυτός διαθέτει μια κεφαλίδα (την πρώτη γραμμή) – επιλέξτε το

κουμπί επιλογής Heading (βλ. Εικόνα 2) και δηλώστε ότι μόνο η 1η γραμμή

αποτελεί κεφαλίδα. Μόλις πατήσετε OK, το Writer δημιούργησε τα κελιά

του πίνακά σας και μένει μόνο να εισάγετε τα περιεχόμενα. Παρατηρήστε

ότι όλα τα κελιά έχουν στοίχιση στο κέντρο. Για να επιλέξουμε ολόκληρο

τον πίνακα υπάρχουν διάφοροι τρόποι. Ένας από αυτούς είναι να τοποθε-

τήσουμε το δρομέα σε κάποιο κελί του πίνακα και να επιλέξουμε το μενού

Table→ Select→ Table. Διαφορετικά, αν τοποθετήσετε το δείκτη του πο-

ντικιού αριστερά της 1ης στήλης εμφανίζεται ένα δεξί μαύρο βελάκι →,

σέρνοντάς το προς τα κάτω/πάνω βλέπετε να επιλέγονται οι γραμμές του

πίνακα. Παρόμοια μπορείτε να επιλέξετε στήλες τοποθετώντας το δρομέα

πάνω από την πρώτη γραμμή του πίνακα και σέρνοντας μόλις εμφανιστεί

το βελάκι ↓. Μπορείτε να επιλέξετε ολόκληρο τον πίνακα πηγαίνοντας τον

δρομέα του ποντικού στην πάνω αριστερή γωνία του πίνακα μέχρι να εμ-

φανιστεί το πλάγιο βελάκι και μετά κάντε κλικ για να τον επιλέξετε.

Αφού επιλέξετε όλα τα κελιά του πίνακα, πατήστε το κουμπί της στοίχισης

στο κέντρο από τη γραμμή εργαλείων μορφοποίησης. Πλέον ότι γράφετε

μέσα στον πίνακα θα στοιχίζεται στο κέντρο.

Μπορείτε να στοιχίσετε τα περιεχόμενα ενός ή περισσότερων κελιών και

κατακόρυφα, επιλέγοντάς τα και πατώντας ένα από τα κουμπιά 9-11 (βλ.

Εικόνα 4) ή με δεξί κλικ και Cell→ Top, Center ή Bottom.

Μπορούμε να πλοηγηθούμε μέσα σε ένα πίνακα, είτε κάνοντας κλικ με

το ποντίκι στο κελί που θέλουμε ή χρησιμοποιώντας τα βελάκια←↑→↓. Με

Tab μεταφερόμαστε στο επόμενο κελί ενώ όταν είμαστε στο τελευταίο κελί

του πίνακα δημιουργείται μια νέα γραμμή. Shift+Tab μας μεταφέρει στο

προηγούμενο κελί.

Μπορούμε ν’ αλλάξουμε το μέγεθος των γραμμών/στηλών του πίνακα το-

ποθετώντας το δρομέα του ποντικιού ακριβώς πάνω σε κάποια γραμμή δια-

χωρισμού κελιών του πίνακα. Ο δρομέας μετατρέπεται σε διπλό βελάκι↔
αν πρόκειται για κατακόρυφη γραμμή και ανάλογα ↕ αν πρόκειται για οριζό-

ντια γραμμή. Κάντε κλικ και σύρτε τη γραμμή με το ποντίκι σε μια νέα θέση.

Θα δείτε ότι το μέγεθος της γραμμής/στήλης άλλαξε.

Όταν τοποθετείτε το δρομέα μέσα στον πίνακα, εμφανίζεται η γραμμή ερ-

γαλείων Table (βλ. Εικόνα 4). Αν όχι, τότε εμφανίστε τη από το μενού View

→ Toolbars→ Table.

 

 

32
 

 

Πίσω στα Περιεχόμενα



 

 

Εικόνα 4: Γραμμή εργαλείων πίνακα

1 Table Είναι το ίδιο με το κουμπί Table που περιγράψαμε

προηγουμένως.

2 Line style Τεχνοτροπία ή στυλ γραμμής (π.χ. εστιγμένο).

3 Line color Χρώμα γραμμής

4 Borders Περίγραμμα κελιού

5 Background color Χρώμα παρασκηνίου

6 Merge cells Συγχώνευση κελιών

7 Split cells Διαίρεση κελιών

8 Optimize Βελτιστοποίηση (ίση κατανομή γραμμών/στηλών,

βέλτιστο ύψος γραμμής, βέλτιστο πλάτος στήλης)

9 Top Στοίχιση κειμένου στο άνω μέρος του κελιού

10 Center Στοίχιση κειμένου στο μέσο του κελιού

11 Bottom Στοίχιση κειμένου στο κάτω μέρος του κελιού

12 Insert Row Εισαγωγή γραμμής

13 Insert Colum Εισαγωγή στήλης

14 Delete Row Διαγραφή γραμμής

15 Delete Column Διαγραφή στήλης

16 AutoFormat Αυτόματη μορφοποίηση

17 Table Properties Ιδιότητες πίνακα

18 Sort Ταξινόμηση

19 Sum Άθροισμα

Ας δούμε πως μπορούμε να χρησιμοποιήσουμε τις παραπάνω εντολές. Για

ν’ αλλάξουμε το στυλ/χρώμα/περίγραμμα γραμμής ή το χρώμα παρασκη-

νίου ενός κελιού/γραμμής/στήλης, το/την επιλέγουμε, όπως μάθαμε προη-

γούμενα, και κάνουμε την επιλογή μας από το αντίστοιχο κουμπί (2-5).

Για να προσθέσουμε μια νέα γραμμή κάτω από την 1η γραμμή του πίνακα

που δημιουργήσαμε ως άσκηση, τοποθετούμε το δρομέα σε κάποιο κελί της

πρώτης γραμμή και πατάμε το κουμπί 12. Για να διαγράψουμε τη γραμμή

που μόλις δημιουργήσαμε, τοποθετούμε το δρομέα σε κάποιο κελί της και

πατάμε το κουμπί 14, ή από το μενού Table→ Delete→ Rows ή δεξί κλικ

και Row→ Delete.

Για να προσθέσουμε μια στήλη δεξιά της 2ης στήλης, τοποθετούμε το δρο-

μέα σε κάποιο κελί της 2ης στήλης και πατάμε το κουμπί 13. Για να διαγρά-

ψουμε τη στήλη που μόλις δημιουργήσαμε, τοποθετούμε το δρομέα σε κά-

ποιο κελί της και πατάμε το κουμπί 15 ή από το μενού Table → Delete →
Columns ή δεξί κλικ και Column→ Delete.

Για να προσθέσουμε μια νέα γραμμή πάνω από την 1η γραμμή του πίνακα

που δημιουργήσαμε ως άσκηση, τοποθετούμε το δρομέα σε κάποιο κελί της

πρώτης γραμμή και επιλέγουμε το μενούTable→ Insert→Rowsή δεξί κλικ

καιRow→ Insert. Από το παράθυρο που εμφανίζεται εισάγουμε τον αριθμό

γραμμών που θέλουμε να εισάγουμε και στη θέση επιλέγουμε “Before” και

ΟΚ. Αντίστοιχη διαδικασία ακολουθούμε για να εισάγουμε στήλες.

Ας προσθέσουμε μια νέα γραμμή στον πίνακα της άσκησής μας όπως φαί-

νεται παρακάτω.

Κατηγορίες Δισκετών

Χαρακτηρισμός

Διαστάσεις

Διπλής πυκνότητας

ή Double Density

(DD)

Υψηλής

πυκνότητας ή High

Density (HD)

3,5” 720 Kb 1,44 Mb

5 ¼” 360 Kb 1,2 Mb
Πίνακας 1: Άσκηση

Πώς όμως η πρώτη γραμμή αποτελείται από ένα μόνο κελί; Επιλέγουμε

την 1η γραμμή και πατάμε στο κουμπί Merge Cells (6) ή από το μενού Table

→Merge Cells ή δεξί κλικ και Cell→Merge.
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Το ανάποδο της συγχώνευσης κελιών είναι η διαίρεση κελιών. Τοποθε-

τήστε το δρομέα σ’ ένα κελί και πατήστε το κουμπί 7 ή από το μενού Table

→ Split Cells ή δεξί κλικ και Cell → Split. Εμφανίζεται ένα παράθυρο το

οποίο σας ρωτάει σε πόσα κελιά να διαιρεθεί το κελί και την κατεύθυνση

της διαίρεσης, δηλ. οριζόντια ή κατακόρυφη.

Μπορείτε ακόμα να διασπάσετε τον πίνακα σε δυο υποπίνακες κάνοντας

κλικ στη γραμμή στην οποία θέλετε να διασπάσετε τον πίνακα και επιλέγο-

ντας το μενού Table→ Split Table ή δεξί κλικ και Split Table. Το διαλογικό

παράθυρο της εικόνας 5 σας δίνει κάποιες επιλογές π.χ. αν θέλετε οι δυο

πίνακες να έχουν τη ίδια επικεφαλίδα κλπ.

 

 

Εικόνα 5: Διαίρεση πίνακα

Επίσης, μπορείτε να προσθέσετε λεζάντα πάνω ή κάτω από τον πίνακα κά-

νοντας δεξί κλικ πάνω του και επιλέγοντας Caption ή από το μενού Insert

→ Caption. Εμφανίζεται το γνωστό από το τεύχος 16 διαλογικό παράθυρο

της εικόνας 6. Εισάγετε τη νέα κατηγορία Πίνακας στο πλαίσιο κειμένου

Category.

 

 

Εικόνα 6: Εισαγωγή υπομνήματος

Μπορείτε περαιτέρω να μορφοποιήσετε το πίνακά σας από το μενού

Table → AutoFit ή από τα μενού Row ή Cell με δεξί κλικ. Έτσι μπορείτε

ν’ αλλάξετε το πλάτος (μήκος) μιας στήλης (γραμμής), να ισοκατανέμετε τις

στήλες (γραμμές) ώστε να έχουν το ίδιο πλάτος (μήκος) ή να βελτιστοποι-

ήσετε το πλάτος (μήκος) τους ώστε να είναι τόσο όσο και το μεγαλύτερο

μέγεθος των δεδομένων που περιέχονται σ’ αυτές.

Μπορείτε ακόμα να μετατρέψετε τον πίνακα σε απλό κείμενο από το με-

νού Table→ Convert→ Table to Text όπου οι διαχωριστικές γραμμές με-

ταξύ των κελιών μετατρέπονται στο χαρακτήρα που επιλέγεται από το δια-

λογικό παράθυρο που εμφανίζεται (π.χ. στηλοθέτες - tabs) ή αντίστροφα να

μετατρέψετε κείμενο που είναι διαχωρισμένο με τον ίδιο χαρακτήρα (π.χ.

στηλοθέτες ή κόμμα) σε πίνακα από το μενού Table→ Convert→ Text to

Table.

Όπως είδατε από την Εικόνα 3, μπορείτε να χρησιμοποιήσετε κάποιο

από τα έτοιμα πρότυπα μορφοποίησης για να μορφοποιήσετε τον πίνακά

σας κατά τη δημιουργία του, ή αν χάσατε την ευκαιρία τότε, να εμφανίστε

το ίδιο διαλογικό παράθυρο από το κουμπί 16, ή από το μενού Table →
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AutoFormat.

Ας δημιουργήσουμε τον παρακάτω πίνακα λίστας με τα ψώνια που κά-

ναμε σήμερα:

Προϊόν Κόστος

10-pack DVD RW 13.95 €

USB stick (32 GB) 28.95 €

SSD (120 GB) 132.00 €

Σύνολο 174.90 €

Ο παρατηρητικός αναγνώστης θα δει ότι χρησιμοποιήθηκε ένα από τα

έτοιμα πρότυπα αυτόματης μορφοποίησης (τοCurrency Lavender, αλλά μπο-

ρείτε να χρησιμοποιήσετε όποιο σας αρέσει) και διαγράφηκαν όσες στή-

λες δεν χρειάζονταν. Για τα κόστη, επιλέξτε τα κελιά της δεξιάς στήλης (πέ-

ραν του πρώτου), δεξί κλικ και Number Format ή από το μενού Table →
Number Format και από το διαλογικό παράθυρο που εμφανίζεται επιλέξτε

Currency. Από δω και στο εξής ότι νούμερο γράφετε σ’ αυτά τα κελιά θα

εμφανίζεται με 2 δεκαδικά ψηφία και το σύμβολο € στο τέλος.

Το σύνολο υπολογίζεται αυτόματα ως εξής: τοποθετείστε το δρομέα στο

τελευταίο κελί της δεύτερης στήλης και πατήστε το κουμπί 19 (βλ. Εικόνα 4)

ή επιλέξτε το μενού Table→ Formula ή πατήστε το πλήκτρο συντόμευσης

F2. Εμφανίζεται η γραμμή εργαλείων που φαίνεται στην εικόνα 7. Επιλέξτε

τα κελιά που θέλετε ν’ αθροίσετε (δηλ. τα κελιά που περιέχουν τα ποσά που

πληρώσατε). Εμφανίζεται ο τύπος: =sum <B2:B4> ο οποίος λέει στο Writer

να υπολογίσει το άθροισμα των κελιών B2 – B4. Αυτή η σύμβαση προέρχε-

ται από το Calc για το οποίο θα έχουμε μια σειρά άρθρων σε μελλοντικά

τεύχη του Ubuntistas, αμέσως μόλις ολοκληρώσουμε την παρουσίαση του

Writer.

Οι γραμμές ενός πίνακα στο LibreOffice χαρακτηρίζονται από έναν

αριθμό, 1 για την πρώτη, 2 για τη δεύτερη κλπ. και οι στήλες από ένα γράμμα,

δηλ. Α για την πρώτη στήλη, Β για τη δεύτερη κλπ. Έτσι, π.χ. το πρώτο κελί

της πρώτης στήλης του πίνακα είναι το Α1, το πρώτο κελί της δεύτερης στή-

λης το Β1 κ.ο.κ. Η μόνη διαφορά με το Calc είναι ότι στο Calc θα εμφανί-

ζονταν παρενθέσεις αντί για <>, δηλ. ο τύπος θα έμοιαζε περισσότερο με

μαθηματική συνάρτηση: =sum (B2:B4).

 

 

Εικόνα 7: Εισαγωγή αριθμητικού τύπου

Πατώντας στο κάτω βελάκι δίπλα από το κουμπί Formula της ομώνυμης

γραμμής εργαλείων βλέπουμε το ρεπερτόριο τύπων που διαθέτει το Writer,

όπως π.χ. λογικές ή τριγωνομετρικές συναρτήσεις κλπ. Μόλις, τελειώσετε,

πατήστε Enter ή το κουμπί Apply για να δείτε το αποτέλεσμα. Και αν ακόμα

δεν πειστήκατε για τα πλεονεκτήματα των παραπάνω, αλλάξτε μια τιμή και

θα δείτε ν’ αλλάζει αυτόματα και το σύνολο μόλις τοποθετήσετε το δρομέα

σε κάποιο άλλο κελί.

Τέλος, ας ταξινομήσουμε τα δεδομένα του πίνακα ως προς την πρώτη

στήλη, ώστε τα προϊόντα να εμφανίζονται αλφαβητικά. Επιλέξτε τη 2η, 3η

και 4η γραμμή και στη συνέχεια το μενού Table→ Sort ή το κουμπί 18. Εμ-

φανίζεται το διαλογικό παράθυρο της εικόνας 8 η οποία σας βοηθάει να ει-

σάγετε τα κριτήρια ταξινόμησης· πατήστε ΟΚ.

 

 

Εικόνα 8: Ταξινόμηση κελιών πίνακα
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Μπορείτε να προστατεύσετε τα κελιά του πίνακα από μελλοντική κατά

λάθος ή μη τροποποίηση, επιλέγοντάς τα και επιλέγοντας το μενού Table→
Protect cells. Παρατηρήστε ότι πλέον δεν μπορείτε ν’ αλλάξετε τα περιεχό-

μενα του πίνακα. Για να απενεργοποιήσετε αυτήν την επιλογή επιλέξτεTools

→ Options → LibreOffice Writer → Formatting Aids και τσεκάρετε το

κουμπί επιλογής Enable κάτω από την ετικέτα Cursor in protected areas.

Έπειτα επιλέξτε τον πίνακα, δεξί κλικ και επιλέξτε Cell→ Unprotect για να

αφαιρέσετε την προστασία. Θα τελειώσουμε την περιγραφή μας με το τε-

λευταίο μενού Table→ Table Properties ή με δεξί κλικ και Table.

 

 

Εικόνα 9: Ιδιότητες πίνακα – καρτέλα Table

Από την καρτέλα Πίνακας μπορείτε να ορίσετε την στοίχιση του πίνακα

στην παράγραφο ή την απόστασή του από τα περιθώρια της παραγράφου.

Από την καρτέλα Text Flow μπορείτε να ορίσετε π.χ. που θα διασπάται ο

πίνακας στις σελίδες, αν επαναλαμβάνεται η γραμμή κεφαλίδας ή όχι, την

κατακόρυφη στοίχιση κλπ.

 

 

Εικόνα 10: Ιδιότητες πίνακα – καρτέλα Text Flow

Από την καρτέλα Columns μπορείτε να ρυθμίσετε τα πλάτη των στηλών.

 

 

Εικόνα 11: Ιδιότητες πίνακα – καρτέλα Columns
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Τέλος από τις καρτέλεςBorders καιBackgroundμπορείτε να μορφοποιή-

σετε τις γραμμές διαχωρισμού των κελιών του πίνακα και το χρώμα φόντου

των κελιών. Παρατηρήστε ότι δεν υπάρχουν πλάγιες γραμμές περιγράμμα-

τος / και \ όπως π.χ. στο Microsoft Word.

 

 

Εικόνα 12: Ιδιότητες πίνακα - καρτέλα Borders

 

 

Εικόνα 13: Ιδιότητες πίνακα - καρτέλα Background

Επίλογος

Σ’ αυτό το άρθρο μιλήσαμε για τις δυνατότητες δημιουργίας και μορφο-

ποίησης πινάκων του LibreOffice Writer. Μάθαμε πως να μορφοποιούμε

έναν πίνακα και καλύψαμε σχεδόν όλες τις δυνατότητες που μας παρέχει

το LibreOffice Writer σχετικά με τους πίνακες. Στο επόμενο άρθρο θα μι-

λήσουμε για τις δυνατότητες που μας παρέχει το LibreOffice Writer για τη

δημιουργία ιστοσελίδων.

Πηγές:

1. LibreOffice (2011), Getting Started with LibreOffice 3.3.

2. LibreOffice (2011),

LibreOffice Writer Guide – Word Processing with LibreOffice 3.3.

3. Chanelle A. (2009), Beginning OpenOffice 3 FromNovice to Professional,

Apress.

4. Miller R. (2005), Point & Click OpenOffice.org!, Prentice Hall.
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http://wiki.documentfoundation.org/images/c/c4/0100GS3-GettingStartedLibO.pdf
http://wiki.documentfoundation.org/images/b/ba/0200WG3-WriterGuide.pdf


 

 

Pygtk - Labels and Buttons του Χρήστου Τριανταφύλλη

Αυτό είναι το δεύτερο μάθημα για τη βιβλιοθήκη Gtk και θα ασχοληθούμε

με τις ταμπέλες (labels) και τα κουμπιά (buttons). Αυτά τα δύο αποτελούν τα

αντικείμενα που θα χρησιμοποιήσετε πιο πολύ.

Και στα δύο παραδείγματα θα δημιουργήσουμε μια δικιά μας κλάση βα-

σισμένη στην κλάση Gtk.Window και θα προσθέσουμε σε αυτή ότι θέλουμε.

Αρχίζουμε με τις labels :

..

#!/usr/bin/python3

from gi.repository import Gtk

class MyWindow (Gtk.Window):

def __init__ (self):

Gtk.Window.__init__ (self, title=”My Window”)

self.label = Gtk.Label (”This is a label”)

self.add (self.label)

Ονομάζουμε την κλάση μας MyWindow και την ορίζουμε ως υπο-κλάση

της Gtk.Window. Στην init της δικιάς μας κλάσης πρέπει να καλέσουμε

την init της Gtk.Window και πιο συγκεκριμένα λέμε να θέσει τον τίτλο

του παραθύρου σε “My Window”.

Συνεχίζουμε δημιουργώντας μια label. Οι labels δέχονται ως παράμετρο

το περιεχόμενό τους, δηλαδή τι θα γράφουν σε αυτές. Τέλος, προσθέτουμε

την label που δημιουργήσαμε στο παράθυρό μας με την εντολή:

..
self.add (self.label)

Τον υπόλοιπο κώδικα τον έχουμε ξαναδεί στο προηγούμενο μάθημα με τη

διαφορά ότι έχω προσθέσει τη γραμμή:

..
win.set_default_size (100, 100)

ώστε να ορίσει το μέγεθος του παραθύρου σε 100x100 (pixels αν δεν κάνω

λάθος). Ολόκληρος ο κώδικας :

..

#!/usr/bin/python3

from gi.repository import Gtk

class MyWindow (Gtk.Window):

def __init__ (self):

Gtk.Window.__init__ (self, title=”My Window”)

self.label = Gtk.Label (”This is a label”)

self.add (self.label)

win = MyWindow ()

win.set_default_size (100, 100)

win.connect (’delete-event’, Gtk.main_quit)

win.show_all ()
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..
Gtk.main ()

Σειρά έχουν τα κουμπιά! Ο κώδικας για τα κουμπιά είναι σχεδόν ο ίδιος,

γι αυτό θα τον δώσω τώρα και θα εξηγήσω τις αλλαγές.

..

#!/usr/bin/python3

from gi.repository import Gtk

class MyWindow (Gtk.Window):

def __init__ (self):

Gtk.Window.__init__ (self, title=”My Window”)

self.button = Gtk.Button (”This is a button”)

self.button.connect (’clicked’, self.on_clicked)

self.add (self.button)

def on_clicked (self, widget):

print (”Button has been clicked!”)

win = MyWindow ()

win.set_default_size (100, 100)

win.connect (’delete-event’, Gtk.main_quit)

win.show_all ()

Gtk.main ()

Όπως βλέπετε, το μόνο που αλλάζει είναι ότι χρησιμοποιούμε τη γραμμή

..
self.button = Gtk.Button (”This is a button”)

για να δημιουργήσουμε ένα κουμπί. Τα κουμπιά μπορούν να δεχτούν ως πα-

ραμέτρους την ταμπέλα που θα έχουν, το εικονίδιο και το αν θα χρησιμοποι-

ήσουν underline (το underline είναι το αν θα υπογραμμιστεί κάποιο γράμμα

στην ετικέτα για να δείξει ποιο πλήκτρο αποτελεί συντόμευση για το συγκε-

κριμένο κουμπί).

Στη συνέχεια συνδέουμε το signal ’clicked’ με τη συνάρτηση

on_clicked. Το signal ’clicked’ ενεργοποιείται όταν κάποιος πατάει

το κουμπί.

Στη συγκεκριμένη περίπτωση η on_clicked απλά γράφει στην έξοδο

”Button has been clicked!”.

Αυτά για το δεύτερο μάθημα...

Στο επόμενο μάθημα θα μιλήσουμε για τα containers (Gtk.Box, Gtk.Grid)

που σου δίνουν τη δυνατότητα να έχεις πολλά αντικείμενα σε ένα παράθυρο

με τη σειρά που τα θες.
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Fogger - Κατεβάστε τις αγαπημένες σας ιστοσελίδες και
διαχειριστείτε αυτές ως web εφαρμογές στον υπολογιστή σας του Ιωάννη Θεοδωρολέα

“Έχετε επισκεφθεί πότε μια ιστοσελίδα που θα θέλατε να δείτε στην επι-

φάνεια εργασίας;” Οι περισσότερες ιστοσελίδες στις μέρες μας έχουν κατα-

σκευαστεί να μοιάζουν περισσότερο ως πλήρης εφαρμογές, αυτό δεν είναι

άσχημο, αλλά μερικές φορές είναι ενοχλητικό το συχνό άνοιγμα νέων καρ-

τελών που βασίζεται στις ανάγκες των αναζητήσεών μας. Όταν θα εγκα-

ταστήσετε το Fogger θα είστε σε θέση να “γεφυρώσετε” τον οποιοδήποτε

αγαπημένο σας περιηγητή με την επιφάνεια εργασίας!

Κύρια λειτουργικότητα

Το Fogger είναι ένα πρόγραμμα που μπορεί να δημιουργήσει αυτόνομες

εφαρμογές web στο Ubuntu desktop σας. Με άλλα λόγια, σας επιτρέπει να

κατεβάσετε ιστοσελίδες και να τις χρησιμοποιείτε ως web apps στην επιφά-

νεια εργασίας.

Πλεονεκτήματα

• Μπορείτε να κατεβάσετε σχεδόν κάθε ιστοσελίδα

• Υποστήριξη εικονιδίου στην επιφάνεια εργασίας

• Χρησιμοποιεί web rendering μηχανή του Gnome

• Μπορεί να χρησιμοποιήσει userscripts

• Αντί απλώς να ενεργεί ως ένα πρόγραμμα περιήγησης, το Fogger παρέ-

χει ένα πλαίσιο για τις ιστοσελίδες και άλλες υπηρεσίες. Οι ιστοσελίδες,

εφαρμογές και υπηρεσίες μπορούν να χρησιμοποιήσουν αυτό το πλαί-

σιο για να επικοινωνούν με το Ubuntu.

• Υποστηρίζει NotifyOSD ειδοποιήσεις.

Μειονεκτήματα

• Μερικές φορές είναι πολύ “buggy” (επιλύονται άμεσα τα προβλήματα).

Εγκατάσταση

Το Fogger θα το βρούμε στο Κέντρο Λογισμικού Ubuntu. Πληκτρολογώ-

ντας στο σημείο αναζήτησης την λέξη Fogger και αμέσως μας δείχνει την

εφαρμογή. Έπειτα πατάμε το κουμπί εγκατάσταση. Αν δεν είναι διαθέσιμο

στο Κέντρο Λογισμικού Ubuntu, τότε θα πρέπει να συμπεριλάβουμε στην

διανομή μας το συγκεκριμένο αποθετήριο απ´ τον συγκεκριμένο σύνδεσμο

όπου είναι και το “σπίτι” του Fogger.

Για την διαδικασία μέσω κονσόλας (terminal) πληκτρολογούμε την εξής

εντολή όπου ακολουθείται και μετά την εγκατάσταση του αποθετηρίου.

..
sudo apt-get install fogger
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https://launchpad.net/~loneowais/+archive/fogger


Δημιουργία fog app.

Ανοίγουμε την εφαρμογή επιλέγοντας Create a new fog app:

 

 

Συμπληρώνουμε με το url και name που επιθυμούμε και επιλέγουμε

create. Αμέσως θα βρούμε στο εφαρμογές/Διαδίκτυο το fog app που δη-

μιουργήσαμε και μπορούμε να το σύρουμε στο cairo-dock ή στην μπάρα

του unity. Επίσης, την εικόνα του νέου μας fog app μπορούμε να την καθο-

ρίσουμε εμείς, διαλέγοντας απ’ το διαδίκτυο η από προσωπικό μας αρχείο

την εικόνα της αρεσκείας μας.

 

 

 

 

Σχόλια χρήστη:

“Το Fogger είναι μια μεγάλη εφαρμογή. Πολλοί άνθρωποι συμφω-

νούν μαζί μου, τόσο στο γεγονός ότι κέρδισε το δεύτερο βραβείο στην

κατηγορίαUbuntuApp Showdown, όσο, ότι μας επιτρέπει να δημιουρ-

γήσουμε web εφαρμογές με μεγάλη ευκολία.”

Συμπέρασμα:

Αν έχετε την ανάγκη ενός τρόπου για την δημιουργία εφαρμογών

web στο Ubuntu το Fogger είναι “τέλειο”. Προσωπικά πιστεύω πως μου

δίνει την ελευθερία να χρησιμοποιήσω οποιοδήποτε πρόγραμμα περιήγη-

σης θέλω, χωρίς να με περιορίζει ως πρόσθετο σε συγκεκριμένο περιηγητή.

Βίντεο: Εγκατάσταση – Δημιουργία Fog app – Διαγραφή Fog app
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https://www.youtube.com/watch?v=JIw88xXPptQ


 

 

Subsurface του Στέργιου Θεοδοσιάδη

 

 

Είμαι καινούργιος χρήστης Linux (Xubuntu σε Laptop) και ενθουσιασμέ-

νος που αρχίζω με κάτι καινούργιο! Χρόνια χρήστης Windows με κακή εμπει-

ρία, με πολλά “κρασαρίσματα” και φορμάτ... Θέλοντας να απαλλαγώ τε-

λείως από το παλιό λειτουργικό και ψάχνοντας για καινούργια προγράμ-

ματα, βρήκα το Subsurface.

Σα νέος κι εγώ έχω κάποια χόμπι, ένα από αυτά είναι οι καταδύσεις (scuba

diving). Με το Subsurface καταχώρισα τις καταδύσεις μου εύκολα και περι-

ληπτικά. Ένα άλλο που μου άρεσε είναι ότι ένας από τους προγραμματιστές

του Subsurface είναι και ο Linus Torvalds. Χα, ένα προγραμματάκι κατευ-

θείαν από τον ”Αρχηγό”.

Λοιπόν το κατεβάζουμε και το εγκαθιστούμε από το Κέντρο λογισμικού

Ubuntu. Στην ουσία το Subsurface είναι πολύ εύκολο και κατανοητό στη

χρήση από δύτες αναψυχής αλλά και από τεχνικούς δύτες. Μπορείς να κα-

ταχωρίσεις βουτιές με αέρα nitrox και trimix, το είδος και την ποσότητα στα

βάρη που θα χρησιμοποιήσεις, τη στολή που θα φορέσεις, να εισάγεις τον

DiveMaster αλλά και τον Divebuddie. Ακόμα, μπορείς να βαθμολογήσεις τις

βουτιές σου αλλά και να γράψεις πληροφορίες για την κατάδυση και το μέ-

ρος που βούτηξες. Λοιπόν το κατεβάζουμε και το εγκαθιστούμε από το Κέ-

ντρο λογισμικού Ubuntu.
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Ένα άλλο ωραίο που δεν είχαν κάποια dive logs που χρησιμοποιούσα εί-

ναι ότι μπορείς να εισάγεις ακριβώς τις συντεταγμένες από το μέρος της

κατάδυσής σου χειροκίνητα αλλά και από google χάρτη ο οποίος είναι εν-

σωματωμένος στο πρόγραμμα.

 

 

Δυνατό σημείο του προγράμματος είναι ότι υποστηρίζει ένα ευρύ φάσμα

από υπολογιστές κατάδυσης, ένα άλλο σημαντικό στοιχείο είναι η ικανό-

τητά του να απεικονίσει το βάθος του προφίλ (και εάν υπάρχουν, τις κα-

μπύλες πίεσης της δεξαμενής), με πολύ καινοτόμους τρόπους που δίνουν

στο χρήστη πρόσθετες πληροφορίες σχετικά με τη Σχετική Ταχύτητα και τη

στιγμιαία κατανάλωση αέρα κατά τη διάρκεια της κατάδυσης.

 

 

Δυνατότητα εκτύπωσης των καταδύσεων με όλες τις πληροφορίες και

πολλά άλλα.

 

 

Ένα εύχρηστο εργαλείο για δύτες.

 

 

43
 

 

Πίσω στα Περιεχόμενα



 

 

Ipcalc - Ένα εργαλείο γραμμής εντολών για τον υπολογισμό
Υποδικτύων και άλλων IP διευθύνσεων του Ιωάννη Παγγέ

Όταν ασχολούμαστε με τα δίκτυα πολλές φορές, είναι πιθανό να ασχο-

ληθούμε με τη δημιουργίας υποδικτύων. Μία μερίδα ανθρώπων έχουν την

ικανότητα να κάνουν με το μυαλό τους το δυαδικό σύστημα και να υπολογί-

ζουν τη σωστή μάσκα υποδικτύου. Ορισμένοι μπορεί να θεωρούν ότι είναι

δύσκολο να υπολογιστεί, για αυτό το λόγο υπάρχει το Ipcalc, το οποίο είναι

ένα εργαλείο στο Linux που να βοηθάει να υπολογίσουμε εύκολα και γρή-

γορα τον αριθμό των υποδικτύων και την σωστή μάσκα (subnet mask).

Το Ipcalc παίρνει μια διεύθυνση IP και τη μάσκα δικτύου και υπολογίζει

την προκύπτουσα εκπομπή δικτύου, ή τις μάσκες των Cisco wildcards, κα-

θώς και πόσους Hosts έχει το δίκτυο. Δίνοντας μια δεύτερη μάσκα, μπο-

ρούμε να σχεδιάσουμε υποδίκτυα και supernets. Επίσης, προορίζεται να

είναι ένα εργαλείο διδασκαλίας και να παρουσιάζει τα αποτελέσματα δη-

μιουργίας υποδικτύων για να είναι εύκολο στην κατανόηση των δυαδικών

τιμών.

Πως κάνουμε εγκατάσταση του Ipcalc

Για να εγκαταστήσουμε to Ipcalc στις διανομές Ubuntu ή Debian ανοί-

γουμε το τερματικό (Ctrl + Alt + t) και εκτελούμε την ακόλουθη εντολή:

..
$ sudo apt-get install ipcalc

Πως χρησιμοποιούμε το Ipcalc

1. Γνωρίζοντας τα πάντα για τη διεύθυνση δικτύου:

..

$ ipcalc 192.168.1.0

Address: 192.168.1.0 11000000.10101000.00000001. 00000000

Netmask: 255.255.255.0 = 24 11111111.11111111.11111111. 00000000

Wildcard: 0.0.0.255 00000000.00000000.00000000. 11111111

=>

Network: 192.168.1.0/24 11000000.10101000.00000001. 00000000

HostMin: 192.168.1.1 11000000.10101000.00000001. 00000001

HostMax: 192.168.1.254 11000000.10101000.00000001. 11111110

Broadcast: 192.168.1.255 11000000.10101000.00000001. 11111111

Hosts/Net: 254 Class C, Private Internet

2. Καθορίζοντας διεύθυνση IP χρησιμοποιώντας το CIDR:

..

$ ipcalc 192.168.1.0/28

Address: 192.168.1.0 11000000.10101000.00000001.0000 0000

Netmask: 255.255.255.240 = 28 11111111.11111111.11111111.1111 0000

Wildcard: 0.0.0.15 00000000.00000000.00000000.0000 1111

=>

Network: 192.168.1.0/28 11000000.10101000.00000001.0000 0000

HostMin: 192.168.1.1 11000000.10101000.00000001.0000 0001

HostMax: 192.168.1.14 11000000.10101000.00000001.0000 1110

Broadcast: 192.168.1.15 11000000.10101000.00000001.0000 1111

Hosts/Net: 14 Class C, Private Internet

3. Εξαγωγή αποτελέσματος χωρίς δυαδικό αποτέλεσμα:
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..

$ ipcalc -b 192.168.1.0/12

Address: 192.168.1.0

Netmask: 255.240.0.0 = 12

Wildcard: 0.15.255.255

=>

Network: 192.160.0.0/12

HostMin: 192.160.0.1

HostMax: 192.175.255.254

Broadcast: 192.175.255.255

Hosts/Net: 1048574 Class C, In Part Private Internet

4. Υπολογισμός ενός μεμονωμένου υποδικτύου με 10 τελικούς χρήστες:

..

$ ipcalc 192.168.1.0 --s 10

Address: 192.168.1.0 11000000.10101000.00000001. 00000000

Netmask: 255.255.255.0 = 24 11111111.11111111.11111111. 00000000

Wildcard: 0.0.0.255 00000000.00000000.00000000. 11111111

=>

Network: 192.168.1.0/24 11000000.10101000.00000001. 00000000

HostMin: 192.168.1.1 11000000.10101000.00000001. 00000001

HostMax: 192.168.1.254 11000000.10101000.00000001. 11111110

Broadcast: 192.168.1.255 11000000.10101000.00000001. 11111111

Hosts/Net: 254 Class C, Private Internet

1. Requested size: 10 hosts

Netmask: 255.255.255.240 = 28 11111111.11111111.11111111.1111 0000

Network: 192.168.1.0/28 11000000.10101000.00000001.0000 0000

HostMin: 192.168.1.1 11000000.10101000.00000001.0000 0001

HostMax: 192.168.1.14 11000000.10101000.00000001.0000 1110

Broadcast: 192.168.1.15 11000000.10101000.00000001.0000 1111

Hosts/Net: 14 Class C, Private Internet

Needed size: 16 addresses.

Used network: 192.168.1.0/28

Unused:

192.168.1.16/28

192.168.1.32/27

192.168.1.64/26

192.168.1.128/25

5. Μπορούμε να υπολογίσουμε πολλά υποδίκτυα χρησιμοποιώντας μόνο

μια εντολή.

..

$ ipcalc 134.1.12.45/20 --s 10 20 20

Address: 134.1.12.45 10000110.00000001.0000 1100.00101101

Netmask: 255.255.240.0 = 20 11111111.11111111.1111 0000.00000000

Wildcard: 0.0.15.255 00000000.00000000.0000 1111.11111111

=>

Network: 134.1.0.0/20 10000110.00000001.0000 0000.00000000

HostMin: 134.1.0.1 10000110.00000001.0000 0000.00000001

HostMax: 134.1.15.254 10000110.00000001.0000 1111.11111110

Broadcast: 134.1.15.255 10000110.00000001.0000 1111.11111111

Hosts/Net: 4094 Class B

1. Requested size: 10 hosts

Netmask: 255.255.255.240 = 28 11111111.11111111.11111111.1111 0000

Network: 134.1.0.64/28 10000110.00000001.00000000.0100 0000

HostMin: 134.1.0.65 10000110.00000001.00000000.0100 0001

HostMax: 134.1.0.78 10000110.00000001.00000000.0100 1110

Broadcast: 134.1.0.79 10000110.00000001.00000000.0100 1111

Hosts/Net: 14 Class B

2. Requested size: 20 hosts

Netmask: 255.255.255.224 = 27 11111111.11111111.11111111.111 00000

Network: 134.1.0.0/27 10000110.00000001.00000000.000 00000

HostMin: 134.1.0.1 10000110.00000001.00000000.000 00001

HostMax: 134.1.0.30 10000110.00000001.00000000.000 11110

Broadcast: 134.1.0.31 10000110.00000001.00000000.000 11111

Hosts/Net: 30 Class B

3. Requested size: 20 hosts

Netmask: 255.255.255.224 = 27 11111111.11111111.11111111.111 00000

Network: 134.1.0.32/27 10000110.00000001.00000000.001 00000

HostMin: 134.1.0.33 10000110.00000001.00000000.001 00001

HostMax: 134.1.0.62 10000110.00000001.00000000.001 11110

Broadcast: 134.1.0.63 10000110.00000001.00000000.001 11111

Hosts/Net: 30 Class B

Needed size: 80 addresses.

Used network: 134.1.0.0/25

Unused:

134.1.0.80/28

134.1.0.96/27

134.1.0.128/25

134.1.1.0/24

134.1.2.0/23

134.1.4.0/22

134.1.8.0/21
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6. Εμφάνιση αποτελεσμάτων ως HTML:

..
$ ipcalc 134.1.12.45/20 –h

Για να μάθουμε περισσότερα σχετικά με το Ipcalc, μπορούμε να αποκτή-

σουμε πρόσβαση στο man page του, το οποίο περιέχει πληροφορίες και

οδηγίες χρήσης, εκτελώντας την ακόλουθη εντολή:

..

$ man ipcalc

$ ipcalc –help

Ηλεκτρονικές Αναφορές

• Ipcalc .

(Πρόσβαση: 2013/10/25)

• Kumar, S., n.d. It’s All About Linux .

(Πρόσβαση: 2013/10/25)
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http://ipcalc.readthedocs.org/en/latest/
http://technicalworldforyou.blogspot.gr/2013/06/ipcalc-command-line-tool-for.html


 

 

Clementine: ένα μοντέρνο πρόγραμμα αναπαραγωγής
μουσικής και οργάνωσης της σε βιβλιοθήκη του Ιωάννη Παγγέ

ΟClementine είναι ένα πρόγραμμα αναπαραγωγής μουσικής, για πολλές

πλατφόρμες είναι εμπνευσμένο από το Amarok 1.4, εστιάζοντας σε μία γρή-

γορη και εύκολη σε χρήση διασύνδεση χρήστη για την αναζήτηση και ανα-

παραγωγή της μουσικής. Μπορείτε να παίξετε μουσικά αρχεία από την μου-

σική αρχειοθήκη, να ακούσετε ραδιόφωνο μέσω διαδικτύου, να δημιουρ-

γήσετε έξυπνες και δυναμικές playlists, να δείτε τους στίχους των τραγου-

διών που ακούτε και τις φωτογραφίες των καλλιτεχνών, να μετατρέψετε

μουσική σε MP3, Ogg Vorbis, Ogg Speex, FLAC ή AAC αρχεία και ένα πλή-

θος ακόμη λειτουργιών.

 

 

Εικόνα 1: Περιβάλλον Clementine

Στο clementine μπορείτε να:

• Αναζητήσετε και παίξετε μουσική από την τοπική σας βιβλιοθήκη.

• Ακούσετε ιντερνετικό ραδιόφωνο από τα Spotify, Grooveshark,

Last.fm, SomaFM, Magnatune, Jamendo, SKY.fm, Digitally Imported,

JAZZRADIO.com, Soundcloud, Icecast και Subsonic servers.

• Αναζητήσετε και αναπαράγετε τραγούδια που έχετε ανεβάσει στο Box,

στο Dropbox, στο Google Drive, στο Skydrive και στο Ubuntu One.

• Δημιουργήσετε έξυπνες και δυναμικές λίστες αναπαραγωγής.

• Δημιουργήσετε λίστες αναπαραγωγής με καρτέλες, εισαγωγή και εξα-

γωγή M3U, XSPF, PLS και ASX.

• Υποστήριξη CUE sheet.

• Αναπαράγετε μουσικά CD.

• Δημιουργήσετε οπτικά εφέ από το projectM.

• Δείτε στίχους και βιογραφίες καλλιτεχνών και φωτογραφίες.

• Κάνετε μετατροπή μουσικής σε MP3, ogg Vorbis, ogg Speex, FLAC ή

AAC.

• Επεξεργαστείτε τις ετικέτες στα mp3 και OGG αρχείων, να οργανώσετε

την μουσική σας.

• Κατεβάσετε τις ετικέτες που λείπουν από το MusicBrainz.

• Ανακαλύψετε και να κάνετε λήψη των podcast.

• Κάνετε λήψη εξώφυλλων για άλμπουμ από το Last.fm και το Amazon.

• Επιπλέον λειτουργεί σε Windows, Mac OS X και Linux.

• Ελέγξετε το Clementine εξ αποστάσεως από το Android κινητό σας.
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https://www.spotify.com/gr/
http://grooveshark.com/
http://www.last.fm/
http://somafm.com/
http://magnatune.com/
http://www.jamendo.com/en/
http://www.sky.fm/
http://www.di.fm/
http://www.jazzradio.com/
https://soundcloud.com/
http://www.icecast.org/
http://www.subsonic.org/pages/index.jsp
https://www.box.com/
http://forum.ubuntu-gr.org/viewtopic.php?f=14&t=29205


• Αντιγράψετε μουσική από το iPod, iPhone, MTP ή USB.

• Δημιουργήσετε λίστες αναμονής.

 

 

Εικόνα 2: Λίστα αναπαραγωγής, ακούγοντας μουσική από πολλαπλές υπη-
ρεσίες στο ίντερνετ

 

 

Εικόνα 3: Λίστα αναπαραγωγής, από την εφαρμογή για Android

Ιστορικό εκδόσεων-ιστορική αναδρομή

• Η πρώτη έκδοση 0.1 κυκλοφόρησε το Φεβρουάριο του 2010.

• Η έκδοση 0.2 κυκλοφόρησε το Μάρτιο του 2010, περιλαμβάνει εξώ-

φυλλα άλμπουμ, καλύτερη ανίχνευση καλλιτεχνών, υποστήριξη λίστας

αναπαραγωγής.

• Η έκδοση 0.3 κυκλοφόρησε το Μάιο του 2010, είναι συμβατή για όλες

τις πλατφόρμες. Τα νέα χαρακτηριστικά περιλαμβάνουν ισοσταθμη-

στή, περισσότερες επιλογές ομαδοποίησης στην βιβλιοθήκη, χειρισμός

από την γραμμή εντολών και το MPRIS, εύκολη επεξεργασία ετικετών.

• Η έκδοση 0.4 κυκλοφόρησε τον Ιούνιο του 2010, περιλαμβάνει λίστες

αναπαραγωγής σε καρτέλες, αναζήτηση στις λίστες αναπαραγωγής, εν-

σωμάτωση του Magnatune, κανονικοποίηση ήχου ReplaiGain και επα-

νακωδικοποίηση μουσικής. Διορθώθηκαν πολλά σφάλματα όπως η

αναζήτηση σε μεγάλες βιβλιοθήκες που είναι πολύ πιο γρήγορη, η ανα-

παραγωγή είναι πιο αξιόπιστη σε Windows, τα προβλήματα κωδικο-

ποίησης χαρακτήρων έχουν διορθωθεί και οι απομακρυσμένες λίστες

αναπαραγωγής φορτώνονται κανονικά.

• Η έκδοση 0.5 κυκλοφόρησε το Σεπτέμβριο του 2010, η έκδοση προ-

σθέτει υποστήριξη για τη χρήση φορητών συσκευών με το Clementine.

Μπορείτε να αντιγράψετε τα τραγούδια στο iPod, το iPhone σας, MTP ή

USB συσκευή μαζικής αποθήκευσης. Άλλα χαρακτηριστικά περιλαμβά-

νουν ένα διαχειριστή λίστας αναμονής, ένα παράθυρο διαλόγου ,οργά-

νωση των αρχείων, στήλες στη λίστα αναπαραγωγής, φόρτωση ενσω-

ματωμένου ID3v2 στο εξώφυλλο, επιλογές σάρωσης στις βιβλιοθήκες,

drag and drop μεταξύ των playlists, και Hypnotoad. Επίσης μειώθηκε ο

χρόνος εκκίνησης κατά περισσότερο από το μισό

• Η έκδοση 0.6 κυκλοφόρησε το Δεκέμβριο του 2010. Η έκδοση περι-

λαμβάνει δύο νέα παράθυρα πληροφοριών, τα στατιστικά στοιχεία του

τραγουδιού, βιογραφίες καλλιτεχνών, φωτογραφίες και τους καταλό-

γους των ετικετών και παρόμοιων καλλιτεχνών. Επανασχεδιάστηκε το
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https://code.google.com/p/clementine-player/wiki/PortableDevices


sidebar, προστέθηκαν αξιολογήσεις.

• Η έκδοση 0.7 κυκλοφόρησε το Μάρτιο του 2011. Υπάρχει ένα ολο-

καίνουργιο παράθυρο διαλόγου, επεξεργασία με αυτόματη συμπλή-

ρωση, τα φύλλα CUE υποστηρίζονται πλέον και υπάρχει υποστήριξη

για proxies δικτύου.

• Η έκδοση 1.0 κυκλοφόρησε το Δεκέμβριο του 2011, προσθέτει το

Spotify, το Grooveshark και το SKY.fm. Προστέθηκε επίσης μια καθο-

λική αναζήτηση που επιτρέπει να βρείτε εύκολα τη μουσική που είναι

στη βιβλιοθήκη σας ή στο διαδίκτυο. Άλλα χαρακτηριστικά περιλαμβά-

νουν υποστήριξη CD, περισσότερες επιλογές transcoder, έξυπνη ανα-

ζήτηση και βελτίωση σφαλμάτων.

• Η έκδοση 1.1 κυκλοφόρησε τον Οκτώβριο του 2012. Η έκδοση προ-

σθέτει το πολυαναμενόμενο Podcast, συμπεριλαμβανομένης της ολο-

κλήρωσης και συγχρονισμού με gpodder.net. Η μουσική από το

Soundcloud και jazzradio.com είναι διαθέσιμες στην καρτέλα Internet

στη sidebar, καθώς και τα τραγούδια που που έχουν ανέβει στο Google

Drive.

• Η έκδοση 1.2 κυκλοφόρησε τον Οκτώβριο του 2013, είναι συμβατή

με την απομακρυσμένη εφαρμογή Clementine για το Android το οποίο

επιτρέπει να ελέγχετε Clementine εξ αποστάσεως από μια συσκευή

Android. Αυτή η έκδοση προσθέτει επίσης υποστήριξη για Subsonic και

τώρα μπορείτε να ακούτε τη μουσική σας που αποθηκεύεται στο Box,

Dropbox, Skydrive και Ubuntu One.

Πηγές

1. Player, C. M., 2013. Clementine.

2. Project Summary, 2013. Clementine.

3. Wikipedia, 2013. Clementine.
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http://www.ohloh.net/p/clementine-player
http://www.clementine-player.org/el/
http://en.wikipedia.org/wiki/Clementine_(software)


 

 

Συμβουλές και κόλπα για τη χρήση του Ubuntu του Ιωάννη Παγγέ

Στο παρόν άρθρο θα παρουσιάσουμε ορισμένες συμβουλές και κόλπα για

την χρήση του Ubuntu. Το Ubuntu είναι μία πλήρης διανομή Linux που απο-

τελείται από ένα σύνολο λογισμικού το οποίο δημιουργεί ένα μοναδικό πε-

ριβάλλον εργασίας χρήστη και προσφέρει στους χρήστες μια σταθερή επι-

λογή εργαλείων.

Unity

Το Unity είναι το προεπιλεγμένο γραφικό περιβάλλον για το Ubuntu. Επί-

σης εισήγαγε τον εκκινητή στην αριστερή πλευρά της επιφάνειας εργασίας

και το Dash (Πίνακας οργάνων) για την έναρξη προγραμμάτων.

Μπορείτε να πατήσετε το πλήκτρο Super (ή Windows Key) για να ξεκινή-

σει το Dash (Πίνακας οργάνων) και να κάνετε αναζήτηση προγραμμάτων και

αρχείων ώστε να τα ανοίξετε από τα αποτελέσματα.

 

 

Εικόνα 4: Πίνακας οργάνων Dash

Προσθήκη καταχωρήσεων στον εκκινητή

Για να προσθέσετε νέες εγγραφές στον εκκινητή μπορείτε να δημιουρ-

γήσετε ένα αρχείο .desktop και το αρχείο να το σύρετε στον εκκινητή. Για

παράδειγμα, η ακόλουθη εντολή δημιουργεί μια καταχώρηση για να ξεκι-

νήσει το Eclipse με διαφορετικές συντομεύσεις για διαφορετικούς χώρους

εργασίας.

..

[Desktop Entry]

Icon=application-x-executable

Name=eclipse

Type=Application

Exec=/home/john/Eclipse37/eclipse

X-Ayatana-Desktop-Shortcuts=Docu;john;business

[Docu Shortcut Group]

Name=Docu

Exec=/home/john/Eclipse37/eclipse -data /home /john/ workspace/ docu

TargetEnvironment=Unity

[john Shortcut Group]

Name=john

Exec=/home/john/Eclipse37/eclipse-data /home/john/workspace/john

TargetEnvironment=Unity

[business Shortcut Group]

Name=business

Exec=/home/john/Eclipse37/eclipse-data /home/john/workspace/business

TargetEnvironment=Unity
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Χρήσιμες συντομεύσεις

Η παρακάτω λίστα παραθέτει μερικές χρήσιμες συντομεύσεις για το πα-

ράθυρο του διαχειριστή του Unity.

Παρατεταμένο πάτημα στο Super

(πλήκτρο Windows)

Δημιουργεί βοήθεια για τις πιο

κοινές συντομεύσεις πληκτρολο-

γίου

Alt + Αριστερό κλικ του ποντικιού
Επιτρέπει να μετακινεί το τρέχον

παράθυρο

Πίνακας 1:Συντομεύσεις παραθύρου

Χρησιμοποιώντας τη κονσόλα

Για να ανοίξετε την κονσόλα ανοίγετε το Dash (Πίνακας οργάνων) και πλη-

κτρολογείτε Terminal. Εναλλακτικά μπορείτε να χρησιμοποιήσετε τον συν-

δυασμό πλήκτρων Ctrl+Alt+T. Αυτό θα ανοίξει ένα παράθυρο που σας επι-

τρέπει να εκτελέσετε εντολές.

Editor (Κειμενογράφος)

Το Ubuntu προσφέρει αρκετούς editors (Κειμενογράφους) που είναι

εγκατεστημένοι από προεπιλογή. Ο πιο κοινός editor σε γραμμή εντολών

είναι ο vim.

Για να εγκαταστήσετε το vim στο Ubuntu μηχάνημα σας, χρησιμοποιήστε

την ακόλουθη εντολή.

..
sudo apt-get install vim

Βρίσκοντας τα αρχεία

Ο παρακάτω πίνακας δείχνει την χρήση της εντολής find.

Εντολή Περιγραφή

find dir -name ”pattern” 2>/dev/null

Βρίσκει αναδρομικά, όλα τα αρ-

χεία που ισχύουν για το πρό-

τυπο «pattern», αρχίζοντας από

τον κατάλογο «dir». To 2> Στέλνει

όλα τα μηνύματα λάθους στη συ-

σκευή null.

find . -name ’*.java’ -newer

build.xml -print

Αναζήτηση για όλα τα αρχεία

java, τα νεότερα αρχεία στη συ-

νέχεια βρίσκονται στο αρχείο

build.xml

find . -name ’*.java’ -mtime +7 -

print

Αναζήτηση για όλα τα αρχεία java

νεότερα των 7 ημερών

find . -name ’*.java’ -mtime +7 -

print0 | xargs -0 grep ’swt’

Αναζήτηση για όλα τα αρχεία java

νεότερα των 7 ημερών χρησιμο-

ποιώντας το ”swt”. Οι επιλογές -0

χρησιμοποιούνται για τα αρχεία

και τους φακέλους με κενό.

Κατάργηση αρχείων

Χρησιμοποιήστε την εντολή ”rm pattern” για να διαγράψετε τα αρχεία.

Να είστε προσεκτικοί με τη χρήση των αρχείων.

..

# Remove all files which ends with .class in the current

directory
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..

rm *.class

# find all files which ends with .class recursive in all

directories below the current one and delete them

find . -type f -name ”*.class” -exec rm -vf {} \;

Συμπίεση αρχείων

Για να συμπιέσετε ή να αποσυμπιέσετε τα αρχεία στη γραμμή εντολών,

μπορείτε να χρησιμοποιήσετε τις ακόλουθες εντολές.

..

# Zip all pdf files in the ~/tmp/pdf/ diretory

zip ~/targetdir/myzip.zip ~/tmp/pdf/*.pdf

# Unzip the zip file

unzip ~/targetdir/myzip.zip

Δημιουργία νέων χρηστών

Για να δημιουργήσετε ένα νέο χρήστη μέσω της κονσόλας χρησιμοποι-

ήστε τις ακόλουθες εντολές. Οι εντολές θα δημιουργήσουν το χρήστη, θα

ορίσετε τον κωδικό του και θα δημιουργήσει έναν προσωπικό κατάλογο για

τον χρήστη. Η -m παράμετρος είναι υπεύθυνη για τη δημιουργία του αρχι-

κού καταλόγου του χρήστη.

..

# create user with home directory

sudo useradd -m -s /bin/bash newuser

# assign password to user

sudo passwd newuser

Μπορείτε επίσης να δημιουργήσετε νέες ομάδες χρηστών και να προσθέ-

σετε το χρήστη στη νέα ομάδα με την ακόλουθη εντολή.

..

sudo addgroup john

sudo usermod -G john newuser

Αυτόματη δημιουργία του καταλόγου home

Σε περίπτωση που χρειαστεί να δημιουργήσετε τον κατάλογο σε μεταγε-

νέστερο στάδιο, μπορείτε να χρησιμοποιήσετε την ακόλουθη εντολή που

δημιουργεί τον κατάλογο home και να αλλάξετε την κυριότητα του καταλό-

γου.

..

# alternatively to using the -m option

# you could create the

# home directory manually

# sudo mkdir /home/newuser

# sudo chown newuser /home/newuser

# sudo chgrp newuser /home/newuser

Δίνοντας πρόσβαση root

Προσοχή: Η ακόλουθη εντολή επιτρέπει στο χρήστη να εκτελέσει τις

εντολές με δικαιώματα υπερχρήστη (root).

..

# either this one

sudo adduser john admin

# or this one should work

sudo adduser john sudo

# afterwards to may want to lock

# the root user

# CAREFUL!!!

# sudo passwd -l root

Για να αλλάξετε το προεπιλεγμένο κέλυφος ενός χρήστη σε bash, ορίστε

την τελευταία καταχώρηση στο αρχείο /etc/passwd (/usr/passwd για
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παλαιότερες εκδόσεις του Ubuntu) για τον εν λόγω χρήστη, σε /bin/bash,

όπως φαίνεται στο παράδειγμα που ακολουθεί.

..
testuser : x :1001 :1001 : : /home/ testuser : / bin /bash

Διαγραφή χρηστών

Για να διαγράψετε ένα χρήστη χρησιμοποιήστε την ακόλουθη εντολή.

..

# delete the user with the name ”john”

userdel john

# delete the user and its home directory

userdel -r username

Δημιουργία Shell Script

Tα Shell Script είναι μικρής διάρκειας προγράμματα που είναι γραμμένα

σε bash (scripting language) και ερμηνεύονται ως διαδικασίες στην κον-

σόλα. Μπορείτε να δημιουργήσετε τα προγράμματα αυτά μέσω ενός κει-

μενογράφου και μπορούν να εκτελεστούν σε ένα παράθυρο τερματικού.

Δημιουργήστε για παράδειγμα, το ακόλουθο αρχείο κειμένου.

..

#!/bin/bash

clear

echo ”Hello, world.”

Μπορείτε επίσης να κάνετε αυτό το αρχείο εκτελέσιμο μέσω της εντο-

λής chmod. Δημιουργήστε για παράδειγμα το παρακάτω αρχείο κειμένου

”popScript”:

..
chmod 777 yourScript

Τώρα μπορείτε να καλέσετε το shell script εκτελώντας./popScript. Θα

πρέπει να τυπώσει ”Hello, world” στην κονσόλα.

Πηγές

• Gismo’s freeware

(Πρόσβαση 2014/1/29)

• Vogel, L., 2013. Vogella.

(Πρόσβαση 30/1/2014)
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Δραστηριότητες κοινότητας του Γιώργου Χριστοφή

Στο διάστημα μέχρι την κυκλοφορία του παρόντος τεύχους, η ελληνική

κοινότητα του Ubuntu πραγματοποίησε διάφορες συναντήσεις με αφορμή

κάποια παγκόσμια γεγονότα όπως Release Parties, Global Jam και άλλα:

• Ubuntu Global Jam Τ-series Αθήνα

• Κοπή πρωτοχρονιάτικης πίτας 2014

• Ubuntu hour Athens – Περιστέρι

• Athens Release party Ubuntu 13.10

• Ubuntu Global Jam S-series Αθήνα

 

 

Η πιο πρόσφατη συνάντηση που πραγματοποίησε η ελληνική κοινότητα

του Ubuntu ήταν αυτή με αφορμή την κυκλοφορία της νέας LTS έκδοσης,

το Release Party για την 14.04 LTS, στην Αθήνα, που πραγματοποιήθηκε την

Κυριακή 27 Απριλίου του 2014.

 

 

Περισσότερο φωτογραφικό υλικό από τις συναντήσεις μπορείτε να

βρείτε εδώ.

Για να ενημερώνεστε σχετικά με τις συναντήσεις της κοινότητας, μπορείτε

να παρακολουθείτε το φόρουμ, τη λίστα ηλεκτρονικού ταχυδρομείου είτε

τα μέσα κοινωνικής δικτύωσης της κοινότητας, διότι αρκετές μέρες νωρί-

τερα από μία συνάντηση γίνονται ανακοινώσεις σε όλα τα παραπάνω μέσα.

Σας περιμένουμε και εσάς να έρθετε, να γνωριστούμε και να συζητή-

σουμε για κάτι που όλοι έχουμε κοινό, τον ενθουσιασμό μας για το ΕΛ/ΛΑΚ,

στις επόμενες συναντήσεις μας!
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https://ubuntu-gr.org/content/%CE%BA%CE%BF%CF%80%CE%AE-%CF%80%CF%81%CF%89%CF%84%CE%BF%CF%87%CF%81%CE%BF%CE%BD%CE%B9%CE%AC%CF%84%CE%B9%CE%BA%CE%B7%CF%82-%CF%80%CE%AF%CF%84%CE%B1%CF%82-2014
https://ubuntu-gr.org/content/ubuntu-hour-athens-%CF%80%CE%B5%CF%81%CE%B9%CF%83%CF%84%CE%AD%CF%81%CE%B9
http://www.ubuntu-gr.org/content/athens-release-party-ubuntu-1310
http://www.ubuntu-gr.org/content/ubuntu-global-jam-athens-15092013
http://forum.ubuntu-gr.org/viewtopic.php?f=34&t=29275&http
http://www.ubuntu-gr.org/photogallery


 

 

u b u n t i s t a s . u b u n t u - g r . o r g

To περιοδικό Ubuntistas σε χρειάζεται!

Για να μπορέσει να συνεχίσει να λειτουργεί το περιοδικό μας, όπως κατα-

λαβαίνετε, χρειάζεται συνεχώς άρθρα.

Αν έχετε κάποια ιδέα ή πρόταση για τη βελτίωση του περιοδικού ή θέλετε

να συνεισφέρετε γράφοντας άρθρα, ή ακόμη αν επιθυμείτε να ενταχθείτε

στην ομάδα του περιοδικού, μπορείτε να επικοινωνήσετε μαζί μας μέσω της

φορμάς επικοινωνίας ή μέσω της ομάδας Ubuntistas στο φόρουμ της ελλη-

νικής κοινότητας του Ubuntu.

Eναλλακτικά, μπορείτε να εκδηλώσετε ενδιαφέρον για σύνταξη ενός άρ-

θρου στο θέμα «Γράψε και εσύ στο περιοδικό Ubuntistas !» στο φόρουμ της

ελληνικής κοινότητας. Αν επιθυμείτε να ενταχθείτε στην ομάδα του περιοδι-

κού μπορείτε να το δηλώσετε στο θέμα «Συμμετοχή στην ομάδα του περιοδι-

κού Ubuntistas».

Το περιοδικό είναι διαθέσιμο από αυτη την ιστοσελίδα καθώς και μέσω του

Κέντρου λογισμικού του Ubuntu.

Ο σχεδιασμός, η επεξεργασία και η ολοκλήρωση του τεύχους, πραγ-
ματοποιήθηκε με τη χρήση του παρακάτω λογισμικού:

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ubuntistas.ubuntu-gr.org
http://ubuntistas.ubuntu-gr.org
http://ubuntistas.ubuntu-gr.org/index.php/contact
http://forum.ubuntu-gr.org/viewtopic.php?f=35&t=21721
https://forum.ubuntu-gr.org/viewtopic.php?f=35&t=29190
https://forum.ubuntu-gr.org/viewtopic.php?f=35&t=29190
http://ubuntistas.ubuntu-gr.org
https://www.libreoffice.org/
http://www.latex-project.org/
http://www.gimp.org/
http://www.inkscape.org/en/
http://www.ubuntu-gr.org/
http://ubuntistas.ubuntu-gr.org

